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Overview

HP Performance Insight

Performance Insight is a performance management application that collects data from many
sources, performs in-depth trend analysis, maintains performance baselines, and provides
users with convenient, web-based reporting. Following is a partial list of product features:

Distributed architecture

Easy to scale (supports data collection from thousands of agents)
CODA/PA agent support

Multi-company security model

Data Warehousing

Near Real Time reporting

Forecasting

Extensive aggregation options (by day, week, month; by location, by customer)
Thresholding and alerting

Easy identification of bottlenecks

Easy assessment of capacity trends

Accurate and timely documentation for management
Integration with NNM

Integration with HP Operations Manager

The reporting solutions created for Performance Insight cover many areas of business
technology optimization. For a list of reporting solutions organized by technology, see
Appendix A, PI Report Packs.
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Data Collection for Interface Reporting

The following datapipes can be used with Interface Reporting:

Interface Discovery Datapipe 2.60 (required)

The Interface Discovery Datapipe discovers interfaces on SNMP-manageable devices and
maintains configuration data for each discovered interface. To ensure continuity of data when
the value of ifTndex changes, the Interface Discovery Datapipe supports the use of an
alternate, persistent attribute, namely:

e ifDescr
e fName
e fAlias

The Interface Discovery Datapipe does not poll interfaces for metrics. It only discovers them.
This datapipe is a prerequisite for other datapipes, including the IR ifEntry Datapipe.
Interface Reporting ifEntry Datapipe 2.53 (required)

Collects data from the MIB-II ifTable in accordance with the polling rule you implement. If
desired, you can configure this datapipe to perform directed-instance polling. Also known as
flagged interface polling, directed-instance polling allows you to specify which interfaces you
want to poll. If your network includes hundreds or possibly thousands of ports feeding desktop
users, and your initial goal is to collect data from a few LAN switch interfaces (the server
ports or the uplink ports), you can use directed-instance polling to restrict data collection to a
smaller subset of interfaces, thereby enhancing performance and scalability.

Interface Reporting Duplex Datapipe 2.00 (optional)

Polls the RFC2665 MIB for OID 1.3.6.1.2.1.10.7.2.1.19, which indicates the status, full or half
duplex, of an interface. The value pulled from the MIB overrides the default for that protocol

type.

Cisco VLAN Datapipe 5.30 (optional)
Collects VLAN configuration information for the VLAN reports in the IR VLAN package.

Interface Reporting OPNET Export Datapipe 2.11 (optional)
Exports MIB-II ifTable data in a format compatible with OPNET.
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Folders, Reports, and Enhancements in Version 5.54

The Interface Reporting Report Pack includes the following report folders:
e Admin

¢ Device

e EtherChannel

e Interface

¢ Location

e Protocol

e VLAN

Reports in the Device, Location, Protocol, and Vendor folders have a customer orientation.
Your first step is to select a customer. Selecting a customer displays a list of devices, locations,
protocols, or vendors that belong to the customer.

The only data in a customer-oriented report is aggregated data. The Device folder aggregates
data by device, which means that data for all enabled interfaces (administratively up
interfaces) has been rolled up to the device level. Similarly, the reports in the Location folder
roll up data for enabled interfaces by location, while reports in the Protocol folder roll up data
for enabled interfaces by protocol.

Reports in the Interface folder have an interface orientation. Each report begins with a table
containing a list of devices in column 1 and a list of interfaces in column 2.

The following table lists the reports in each folder.

Folder Folder Contents

Admin e Configuration & Logging
e Inventory
e System Performance

e Top Level Inventory

Interface e Availability Detail

e (Capacity Planning

e Discard Exceptions

e Error Exceptions

e Exception Hot Spots

¢ Grade of Service

e Utilization and Volume

¢ Near Real Time

¢ Near Real Time Snapshot
e Service Level Management
e Simple NRT

e Top Ten

e Unreachable

e Utilization Exceptions
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Folder Folder Contents

Device e (Capacity Planning

¢ Exception Hot Spots

¢ Priority Customer

¢ Service Level Management
e Top Ten

VLAN e Exception Hot Spots
e Near Real Time

¢ Top Ten

e Traffic Utilization

Etherchannel e Exception Hot Spots
e Near Real Time

Location e (Capacity Planning

¢ Executive Summary

¢ Priority Customer

e Service Level Management
e Top Ten

Protocol e (Capacity Planning

e Executive Summary

e Service Level Management
e Top Ten

e Priority Customer

Vendor e (Capacity Planning

e Executive Summary

e Make and Model Top Ten

e Priority Customer

e Service Level Management
e Top Ten

The reports listed above will help you maintain service levels, assess capacity constraints, and
spot problem areas before they become serious. Interface Reporting does the following chores
for you, automatically:

e Monitor exceptions (discard exceptions, error exceptions, utilization exceptions)

e Ranking (spot the extremes — trunks, locations, protocols that rank in the top ten)

e Sort interfaces by rate of growth over the rolling baseline period

e Highlight devices that are expected to exceed utilization thresholds in the near future
e Estimate future utilization based on behavior during the baseline period

e Correlate future performance by day-of-week

e Show performance for a device, trunk, or EtherChannel in near real time

e Compare today’s activity to yesterday
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Compare today’s activity to last week and last month

Compare last month’s activity to previous months

Interface Reporting Report Pack enables you to delete Devices or Interface Types or
Interfaces using the PI Delete Managed Object wizard. Note that this wizard will not delete
any other type of objects.

For more information on PI Delete Managed Object wizard, see HP Performance Insight
Administration Guide.

Enhancements in Version 5.54

Types

Overview

Version 5.54 includes the following upgrade packages:

Interface_Reporting_Upgrade_to_554
Interface_Reporting_Device_Upgrade_50_to_531
Interface_Reporting_Location_Upgrade_50_to_531
Interface_Reporting_Protocol_Upgrade_50_to_531
Interface_Reporting_Vlan_Upgrade_to_53
Interface_Reporting_ifEntry_Datapipe_Upgrade_to_253
IR_OPNET_Export_Datapipe_Upgrade_to_211
IRifEntry_Duplex_Datapipe_Upgrade_10_to_20
IFEntry_Disc_Datapipe_Upgrade_to_260

of Reports

See below for a brief description of each type of report.

Availability Detail. Displays a list of interfaces that were unavailable for at least part of
the previous day.

Capacity Planning. Forecasts busy-hour utilization and sorts interfaces, devices,
locations, protocols, or vendors by rate of growth.

Configuration and Logging. Displays configuration settings that determine how
collections are performed; displays an entry for each transfer from the datapipe to the
report pack, indicating when the transfer took place and the number of rows that were
mapped to the report pack.

Exceptions. Identifies the interfaces with the highest number of discard exceptions,
error exceptions, or utilization exceptions.

Exception Hot Spots. Identifies the trunks, interfaces, VLAN interfaces, and devices
with the highest number of exceptions.

Executive Summary. Aggregates volume, exception counts, and utilization by
protocol, location, or vendor.

Grade of Service. Identifies the ten worst performing interfaces and assigns a grade to
each interface based on utilization, error, and discard exceptions.
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Inventory. Shows which devices are provisioned and property data associated with
devices and interfaces. Top Level Inventory shows the total number of devices for each
customer, the total number of interfaces for each customer, and a breakdown by make and
model.

Near Real Time. Provides utilization, error, and discard data for active interfaces,
trunks, and EtherChannels; the time period begins with the most recent poll and goes
back six hours; drill-down to daily and monthly data.

NRT Snapshot. Provides utilization, error, and discard data for one device, multiple
devices, or specific interfaces on one device; same time period as Near Real Time.

Priority Customer. These reports provide availability, exception and volume metrics for
selected high priority customers and their managed elements. They are suitable for wall
board displays with an hourly refresh, allowing management and staff to see the current
state of their network from a customer perspective at a high level. No data will appear in
these reports unless you assign Priority to the customer/device, customer/location,
customer/protocol or customer/vendor combinations using the Assign Priority forms under
General Tasks in the Property/Object Manager window.

Service Level Management. Identifies interfaces, devices, locations, protocols, and
vendors with lowest availability and highest response time.

Simple Near Real Time. A subset of Near Real Time; provides statistics for the previous
six hours and an hourly view of utilization, discards, and errors. Intended for easy
integration with the NMS.

System Performance. Measures duration, in seconds, for groups of related tasks
performed by the report pack.

Top Ten. Identifies interfaces, VLAN interfaces, trunks, devices, locations, protocols, and
vendors with the highest volume and the lowest volume.

Unreachable. Provides a list interfaces for which no data has been received for 35
minutes; excludes interfaces for which no data has been received for more than six hours.

) Unreachable reports do not support the LIR feature. You can open and view the
Unreachable reports only on a standalone server and not in a distributed setup.
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Rules and Actions for Thresholds

Overview

You can enhance fault isolation and problem diagnosis by integrating NNM and PI. If NNM
and PI are integrated, the NNM operator will have access to the Report Launchpad window.
From the Report Launchpad window, the NNM operator can launch any report in Interface
Reporting.

If NNM and PI are integrated, be sure to install the optional thresholds sub-package that
comes with Interface Reporting. The optional thresholds sub-package contains a thresholds
policy. The thresholds policy defines:

e Threshold conditions specific to Interface Reporting
e An action for PI to take when a threshold is breached
e An action for PI to take when a breach condition returns to normal

Configuring the Thresholds Module is not necessary. You do not need to configure thresholds,
define actions, or specify a destination for threshold traps. However, you may modify category,
severity, and destination parameters at any time. For details about these options, refer to the
Thresholds Module User Guide.

The following table provides details about the thresholds policy contained in the optional
thresholds sub-package.

Threshold Data Type |Description Severity

InDiscards NRT In Discard percentage exceeds discard | Warning
exception level.

OutDiscards NRT Out Discard percentage exceeds Warning
discard exception level.

InErrors NRT In Error percentage exceeds error Minor
exception level.

OutErrors NRT Out Error percentage exceeds error Minor
exception level.

InUtilization NRT In Utilization percentage exceeds Warning
utilization exception level.

OutUtilization NRT Out Utilization percentage exceeds Warning
utilization exception level.

Availability NRT Availability less than exception level. | Warning

UtilException Hourly Utilization exceeds threshold in more | Warning
than 45% of samples.

DiscardsException | Hourly Discards exceed threshold in more Warning
than 45% of samples.

ErrorsException Hourly Errors exceed threshold in more than | Minor

45% of samples.
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Threshold Data Type |Description Severity

InUtilForecast Daily 30 day forecast In Utilization exceeds | Warning
utilization exception level.

OutUtilForecast Daily 30 day forecast Out Utilization Warning
exceeds utilization exception level.

The thresholds in the preceding table are defaults. You can easily modify any default on a
per-interface basis by using the Change Interface Properties form. For details about this form,

see Chapter 7, Change Forms.
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Sources for Additional Information

Overview

This guide includes samples of some reports. The demo package that comes with Interface
Reporting contains a sample of every report in the package. If you have access to the demo
package, and you want to know what fully-populated reports look like, install the demo
package. Demo reports are interactive, but unlike real reports, the data in a demo report is
static.

For information regarding the latest enhancements to Interface Reporting and any known
issues, refer to the Interface Reporting Report Pack Release Notes, September 2009. You may
also be interested in the following documents:

e (Cisco VLAN Datapipe Release Notes

e Common Property Tables User Guide

e Executive Summaries Report Pack User Guide

e [Interface Discovery Datapipe User Guide

e [Interface Reporting ifEntry Datapipe User Guide
e  NNM/PI Integration User Guide

e PI Report Packs Release Notes

e Thresholds Module User Guide

The user guides for the core product, Performance Insight, and the user guides for the
reporting solutions that run on Performance Insight, can be downloaded from this site:

http://h20230.www2.hp.com/selfsolve/manuals

The user guides for the core product are listed under Performance Insight. The user guides for
report packs and datapipes are listed under Performance Insight Report Packs. Each guide
indicates a date. If a guide is revised and reposted, the date will change. Since we post revised
manuals on a regular basis, you should check the web for updates.
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2 Upgrade or Install

Guidelines for Upgrade

The report pack CD contains report packs, datapipes, and several shared packages. To extract
these packages from the CD to the Packages directory on your system, insert the report pack
CD in the CD-ROM drive and launch the package extraction program. When the extract
finishes, the install script will prompt you to launch PI and start Package Manager.

If the package extraction step has already taken place, all of the packages associated with
Interface Reporting, including the latest upgrade packages, are in the Packages directory on
your system awaiting installation. To upgrade Interface Reporting, start Package Manager
and follow the on-screen instructions. Before beginning the upgrade, be familiar with the
following topics:

e Prerequisites for Interface Reporting 5.54
e Datapipes and remote pollers
e Custom table views

e Upgrading Interface Reporting in a distributed environment

Prerequisites for Interface Reporting 5.54

Make sure the following software is already installed before upgrading Interface Reporting:
e PI 5.41, with all available service packs for PI 5.41

e Interface Reporting 5.50

e Common Property Tables 3.92

You may have some or all of the following datapipes installed:

¢ JRifEntry Duplex Datapipe 2.00

¢ (CiscoVLAN_Datapipe 2.20

e Interface Discovery Datapipe 2.60

e JRifEntry Datapipe 2.53

e IR OPNET Export Datapipe 2.11

Datapipes and Remote Pollers

When you uninstall an existing datapipe, the following information is lost:
e Single polling policy for a remote poller

e (Cloned polling policies for multiple remote pollers
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¢ (Customized polling groups

To prevent this information from being lost, export existing polling policy configurations and
customized polling groups by using the following commands:

e collection_manager

® group_manager

Exporting Polling Policy Configurations
If your environment contains polling policies for remote pollers, use the collection_manager
command to export existing policy configurations to a file.
UNIX: As user trendadm, run the following command:
cd $DPIPE_HOME
./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the PI install directory
and execute the following command:

bin\collection _manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to
export groups to individual .xml files.

UNIX: As user trendadm, execute the following command:
cd $DPIPE_HOME
./bin/group manager -export all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the PI install
directory and execute the following command:

bin\group manager -export all -outfile \temp\savePollingGroups

Custom Table Views

If you created custom table views, the views you created may interfere with the report pack
upgrade, causing the upgrade to fail. Whether or not your views interfere with the upgrade
process depends on how you created them. If you created them using SQL, the upgrade will
succeed, however, your views will not be available once the upgrade is complete. If you created
them using Datapipe Manager, the upgrade is likely to fail. To prevent the upgrade from
failing, delete the views you created before you upgrade the report pack, then, after the report
pack is upgraded, recreate your custom views.

Distributed Environments

If you are running PI as a distributed system, every server must be running PI 5.41 and all
the Service Packs available for PI 5.41. Here is an overview of the installation procedure for
distributed environments:

1 Disable trendcopy on the central server.

2 For the central server:
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e Upgrade to Interface Reporting 5.54; deploy reports.

¢ Re-edit the process files containing trendcopy directives for Device, Location and
Protocol; these files were overwritten during the upgrade process.

For each satellite server, upgrade to version 5.54 and deploy reports.
Re-enable trendcopy on the central server.

Reconfigure the central server and each satellite server. For details, see Chapter 4,
Setting Up a Distributed System.

Upgrading to Version 5.54

Task 1:

Upgrade or Install

Perform the following tasks to upgrade to Interface Reporting 5.54:

Task 1: Stop OVPI Timer and extract packages from the report pack CD

Task 2: Install the Interface Reporting “UPGRADE_Interface_Reporting_to_554" upgrade
package

Task 3: Restart OVPI Timer

If you are using the “Poll Flagged Interfaces Only” polling rule, you must re-provision the poll
flag after this upgrade. Refer to the Interface Reporting ifEntry Datapipe User Guide for
details.

Stop OVPI Timer and extract packages from the report pack CD

1
2

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
Windows: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Solaris: sh /etc/init.d/ovpi_timer stop

Insert the report pack CD. On Windows, a Main Menu displays automatically; on UNIX,
mount the CD if the CD does not mount automatically, navigate to the top level directory
on the CD, and run the . /setup command.

Type 1 in the choice field and press Enter. The install script displays a percentage
complete bar. When the copy is complete, the install script starts Package Manager. The
Package Manager welcome window opens.

Once the extract is finished, the Interface Reporting folder under the Packages directory on
your system will contain the following folders:

Docs

Interface_Reporting.ap
Interface_Reporting_Demo.ap
Interface_Reporting_Device.ap
Interface_Reporting_Location.ap

Interface_Reporting_Protocol.ap
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Interface_Reporting_Thresholds.ap
Interface_Reporting_Vlan.ap
UPGRADE_Interface_Reporting_to_554.ap

Task 2:  Install UPGRADE_Interface_Reporting_to_554

1
2
3

9

Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.

Click Install. Approve the default installation directory or select a different directory if
necessary.

Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the defaults for application server name and port; type your user name and
password for the PI Application Server.

Click Next. The Package Selection window opens.
Click the check box next to the following package:
UPGRADE _Interface_Reporting_to_554

Click Next. The Type Discovery window opens. Disable the default and click Next. The
Selection Summary window opens

Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package install complete message appears.

) The UPGRADE package you installed might sometimes disappear from view. This
is not an error. The Package Manager will display what you just installed as
Interface Reporting 5.54.

Click Done to return to the Management Console.

Task 3:  Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Solaris: sh /etc/init.d/ovpi_timer start

Package Removal

If you uninstall the Interface Reporting package, the IR ifEntry Datapipe will be removed
automatically. Uninstalling the Interface Reporting package does not affect the Interface
Discovery Datapipe. Follow these steps to uninstall Interface Reporting:

1
2

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
Windows: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
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Upgrade or Install
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10
1
12

13
14

Solaris: sh /etc/init.d/ovpi_timer stop

Launch Performance Insight and start Package Manager. The Package Manager welcome
window opens.

Click Next. The Package Location window opens.
Click Uninstall.
Click Next. The Report Undeployment window opens.

If you deployed the reports in Interface Reporting from this server, accept the defaults for
Undeploy Reports, Application Server Name, and Port. Otherwise, clear the check box and
skip to step 9.

Type the username and password for the PI Application Server.

Click Next. The Package Selection window opens. Click the check box next to the following
packages:

a Interface Reporting

b Interface Reporting Device

¢ Interface Reporting Location

d Interface Reporting Protocol

e Interface Reporting Thresholds

t  Interface Reporting Vian

g Interface Reporting Demo

Click OK.

Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens and the removal process begins. When the
uninstall process is complete, a package removal complete message appears.

Click Done.
Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Solaris: sh /etc/init.d/ovpi_timer start
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3 The New Install

Guidelines for Installation

An PI reporting solution has two ingredients, a report pack and a datapipe. Some reporting
solutions include multiple datapipes. When you install a datapipe, you configure PI to collect
a specific type of performance data at a specific interval. When you install a report pack, you
configure PI to summarize and aggregate the data collected by the datapipe.

If the packages on the report pack CD-ROM were extracted to the Packages directory on your
system, Interface Reporting is available for installation. If packages were not extracted from
the report pack CD, follow the extract procedure in this chapter. Once the extract is done, you
can install Interface Reporting by starting Package Manager and following the on-screen
instructions. Before using Package Manager, review the following guidelines related to
prerequisites, Common Property Tables, and distributed environments.

Prerequisites Related to Pl

Follow these steps before proceeding further:

1 Make sure the following software is already installed:
e PI5A41
e All available Service Packs for PI 5.41

This chapter does not discuss database configuration, sizing, or tuning. For help with
those tasks, see the HP PI Installation Guide. If you need help installing a Service Pack,
refer to the release notes that were issued with the Service Pack.

2  Turn off OVPI Timer. If OVPI Timer is not turned off, the system will begin doing things
before you finish tuning the report pack.

3 Using one of the following techniques, populate your node list:
¢ Do it manually
¢ Run PI SNMP discovery
e Import a list of nodes exported from another application (for example, NNM)

¢ Add the nodes to a file and use node_manager.exe to import the file

Prerequisites Related to SNMP Polling

1 Open the SNMP Edit Profile window (Polling Policy Management > Edit > SNMP Profiles) and
edit the following fields:

a Increase the default for OIDs-per-PDU.
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The default for the number of OIDs-per-PDU is 20. IR’s raw collection polls 28 OIDs.
Unless the OIDs-per-PDU is adjusted, PI will send two PDUs to the polled device.
Changing the default to 30 will cut in half the number of packets sent to each device.

) Not all SNMP agents permit large request packets. If the agent does not allow 28

‘ OIDs, you may see a message indicating that your request packet is too large.
Your options are to send more packets that are smaller, or create a separate
SNMP profile that reduces the OID count, and assign that policy to the nodes that
cannot sustain the 30-OID policy.

) The default for OIDs-per-PDU is set by PI. Upcoming releases of PI may use a
different default. If the default is correct, no changes are necessary.

b  Reduce the default for the SNMP timeout.

If you have a reliable, high-speed network, reduce the timeout default. Reducing the
default will shorten the polling window.

¢ Lower the default for SNMP retries.

If you have a reliable, high-speed network, do not keep retrying a non-responsive
device. The default, 5 retries, is usually overkill. Drop this down to 1 or even 0. It is
better to lose a poll for a device than to keep retrying an unavailable device.

Increase the default for the number of child pollers.

The SNMP poller is mw_collect. Mw_collect spawns one child poller for each polled device.
The default is 5 child pollers, which is analogous to a process window that sustains 5
active child pollers at any one time, initiating a new child poller as soon as the preceding
child poller completes.

»

The number of child pollers is controlled by the “-¢” argument. To make polling more
efficient, increase the number of child pollers (to 25, 35, or even 50) by editing the
following file:

<DPIPE HOME>/1ib/trendtimer.sched

Edit the file by adding “-c n” to the mw_collect entries for 5, 10, 15, 20, 60, 1440-minute
invocations.

Activate SNMPv2 GETBULK retrieval.

PI provides GETBULK retrieval for SNMPv2 (snmpv2c) collections. Using GETBULK can
significantly reduce the number of SNMP PDUs that PI sends to target nodes. Reducing
the number of SNMP PDUs makes polling more efficient and may, depending on how the
vendor’s SNMP agent was implemented, reduce the load on polled devices.

To activate SNMPv2 GETBULK, add the “-e” argument to mw_collect. For example:
5 - {DPIPE_HOME}/bin/mw_collect -m -i 5 -K 1 -c 250 -e

10 - {DPIPE_HOME}/bin/mw_collect -m -i 10 -K 1 -c 250 -e
15 - {DPIPE_HOME}/bin/mw_collect -m -i 15 -K 1 -c 250 -e
20 - {DPIPE_HOME}/bin/mw_collect -m -i 20 -K 1 -c 250 -e
60 — {DPIPE_HOME}/bin/mw_collect -m -i 60 -K 1 -c 250 -e
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Common Property Tables

If you are running an older version of Common Property Tables, version 3.90 or earlier,
upgrade to version 3.92 by installing the upgrade package

UPGRADE_CommonPropertyTables_to_392. If you are not running any version of Common
Property Tables, let Package Manager install the latest version of Common Property Tables

for you. Do not install the upgrade for Common Property Tables and other packages at the
same time. Install the upgrade for Common Property Tables and only the upgrade for
Common Property Tables. For details about this package, refer to the Common Property

Tables User Guide.

Distributed Environments

If you intend to run Interface Reporting as a distributed system, every server must be
running the same version of PI as well as all available Service Packs for that version. An

outline of the installation procedure follows.

Central Server

Install the following packages on the central server:

When installing these packages on the central server, deploy reports.

Interface Reporting
Device sub-package
Location sub-package
Protocol sub-package
VLAN sub-package

Satellite Servers

The New Install

Some packages are mandatory, some are optional. These are the mandatory packages:

Interface Reporting

Device sub-package

Interface Discovery Datapipe 2.60
Interface Reporting ifEntry Datapipe 2.53

This packages are optional:

Location sub-package

Protocol sub-package

VLAN sub-package

Interface Reporting Thresholds
Cisco VLAN Datapipe 2.2
OPNET Export Datapipe 2.11
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When package installation is complete, your next step is to set up connections with satellite
server databases, configure trendcopy pull commands, and switch off daily and monthly
aggregations at each satellite server. These steps are covered in Chapter 4, Setting Up a
Distributed System.

Installing and Tuning Interface Reporting

Task 1:

This section covers the following tasks:

e Task 1: Extract packages from the report pack CD

e Task 2: If necessary, upgrade to Common Property Tables 3.92

e Task 3: Install Interface Reporting and both datapipes

e Task 4: Turn off polling policies for the IR ifEntry Datapipe

e Task 5: Use the IR_Configure utility to check and adjust polling rules

One of the polling rule options you can implement using the IR_Config.pl utility is Poll Flagged
Interfaces Only. If your network includes hundreds or possibly thousands of ports feeding
desktop users, you can enhance performance by using the flagged interfaces only option to
restrict data collection to a smaller subset of interfaces. For details, refer to the IR ifEntry
Datapipe User Guide.

e Task 6: Use the Administration form to set the provisioning mode

e Task 7: Restart OVPI Timer

e Task 8: De-activate unwanted ifTypes (protocols) and adjust default thresholds
e Task 9: Turn back on the polling policies you turned off in Task 4

e Task 10: Provision customers and locations

e Task 11: Export provisioning data from PI for safekeeping

Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.
2 If OVPI Timer process is running, stop it and wait for processes to terminate.
Windows:
a From the Control Panel, select Administrative Tools > Services
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Solaris: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu displays
automatically; on UNIX, mount the CD manually if the CD does not mount automatically,
then run the setup command.
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Task 2:

Task 3:

The New Install

4 Select PI report packs by typing 1 in the choice field and pressing Enter. The install script
displays a percentage complete bar. When extraction is complete, the install script starts
Package Manager. The Package Manager welcome window opens.

Once the extract is finished, you can navigate to the Interface Reporting folder, under the
Packages directory, to see the packages that are available for installation. The Interface
Reporting contains the following sub-folders:

* Docs

e Interface_Reporting.ap

¢ Interface_Reporting_Demo.ap

e Interface_Reporting_Device.ap

¢ Interface_Reporting_Location.ap

e Interface_Reporting_Protocol.ap

e Interface_Reporting_Thresholds.ap

e Interface_Reporting_Vlan.ap

e UPGRADE_Interface_Reporting_to_554.ap

You can ignore the upgrade package. Installing the demo package is optional.

Upgrade Common Property Tables

This task is necessary only if you are currently running an older version of Common Property
Tables. Upgrade to version 3.92 by installing the upgrade package. Observe these rules:

e Install the upgrade by itself; install no other packages.

e  When the Report Deployment window opens, accept the default to Deploy Reports. By
deploying reports, you will also deploy the forms that come with Common Property Tables.

e  When the install finishes, click Done to return to the Management Console.

If you need help with the upgrade, refer to the Common Property Tables User Guide.

Install Interface Reporting and all mandatory datapipes

1 Start Package Manager. The Package Manager welcome window opens.
2  Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select
a different directory if necessary.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the default for application server name and port; type the username and password
for the PI Application Server.

5 Click Next. The Package Selection window opens.
6  Click the check box next to the following packages:
a Interface Discovery Datapipe
b Interface Reporting ifEntry Datapipe
¢ Interface Reporting Duplex Datapipe
d Cisco VLAN Datapipe (optional)
e OPNET Export Datapipe (optional)
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Task 4:

Task 5:

t  Interface Reporting
g Interface Reporting Device
Interface Reporting Location (optional)
i Interface Reporting Protocol (optional)
i Interface Reporting Thresholds (optional)
k  Interface Reporting Vian (optional)
| Interface Reporting Demo

) If you do not want protocol and location statistics, do not install the protocol and
‘ location sub-packages. Installing these sub-packages forces the database server to
allot resources to additional summarizations.

7  Click Next. The Type Discovery window opens. To run Type Discovery immediately after
package installation, accept the default.

8 Click Next. The Selection Summary window opens.

9  Click Install. The Installation Progress window opens and the install process begins. When
the install finishes, a package install complete message appears.

10 Click Done.

Turn off polling policies for the IR ifEntry Datapipe

You do not want raw collections to begin until you have configured the report pack for ifType
monitoring. From the Management Console, open Polling Policy Management and turn off the
following polling policies for IR collections:

e ifName Collection
e ifIndex_Collection
e ifDescr Collection

e ifAlias_Collection

Use the IR_Config.pl utility to check and adjust polling rules

The IR ifEntry Datapipe includes a configuration tool. Use the configuration tool to adjust the
polling rule. These are your polling rule options:

e Poll all active interfaces

e Poll all interfaces

e Poll all active interfaces with monitored protocols (default)
e Poll all interfaces with monitored protocols

e Poll flagged interfaces only

If you want to adjust the default, launch the configuration tool (IR_Config.pl) and change it.
For details about polling flagged interfaces only (also known as directed-instance polling),
refer to the Interface Reporting ifEntry Datapipe User Guide.
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Task 6:

Task 7:

Task 8:

Task 9:

Task 10:

The New Install

If necessary, use the Administration form to change the default provisioning mode

The provisioning mode determines whether values sourced from the network override the
user, or whether the user overrides values sourced from the network. The default is that
values set by the user for ifIndex, ifName, and ifDescr will not be over-written by values
sourced from the network.

However, if your network is dynamic and if you want to be able to adapt to changes, then the
default may not be appropriate. To change the default, open the Object Management view and
select the Administer Interface Reporting form. When the form opens, set the provisioning mode
to 1.

Restart OVPI Timer

Windows:
a From the Control Panel, select Administrative Tools > Services
b  Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Solaris: sh /etc/init.d/ovpi_timer start

Deactivate ifTypes (protocols) you do not want and adjust default thresholds

1 Open the Change Protocol Defaults form.

2 Deactivate any ifTypes you do not want included in reports by toggling the status from
monitored to not monitored. If desired, operate in lock-down mode by deactivating all
ifTypes. If you deactivate all ifTypes, you must enable certain ifTypes later.

) If you are polling flagged interfaces only, the ifTypes you do not want included in
reports have already been deactivated.

3 Adjust default thresholds on a per-ifT'ype basis. When Interface Reporting discovers new
interfaces on a device, it will add a new row to the KIRDevPorts property table. This new
row will include the threshold values established by this form.

Turn on the polling policies you turned off in Task 4.

Your implementation is properly configured. You are retrieving ifEntry data from the desired
interfaces, timeouts are not wasting time, SNMP retry requests are not wasting time, and you
are transmitting the least number of SNMP datagrams required to retrieve the OIDs. It is
now safe to turn on the polling policies you turned off in Task 4.

Provision customers and locations

There is no need to assign a customer and a location to an interface. The interface will inherit
customer and location from the parent node. If you want to override the inherited values, then
you must assign a customer and location to the interface.

To assign a parent node to a customer and location, navigate the Object/Property
Management view, select a node, and open the Update Node Information form under Object
Specific Tasks.
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Task 11:  Export provisioning data from Pl for safekeeping

Export property information from PI. If for any reason you need to uninstall and reinstall the
report pack, you can use the export file to immediately re-import property information.

Accessing Deployed Reports

When you installed Interface Reporting, you enabled the Deploy Reports option. As a result,
the reports in this package (as well as any forms that come with reports) were deployed to the
PI Application Server. Once reports reside on the PI Application Server, you can view the
reports using the PI client applications or you can view reports on the Web.

If the client applications are installed on your system, you have access to Report Viewer,
Report Builder, and the Management Console. If you do not have the client applications, then
you must use the web interface to view reports.

For more information about the clients, refer to the PI Installation Guide. For details about
the Management Console, including how to use the Object/Property Management view to
launch reports specific to a selected object, refer to the PI Administration Guide.

New Obiject Categories in the Pl Object Model

The PI object model allows you to navigate to an object, perform tasks that pertain to the
object, or open reports that pertain to the object. Installing a new report pack modifies the
object model, adding one or more object categories. Installing Interface Reporting adds one
object category to the object model: interface.

Selecting any object in the object model, including an interface, causes the right side of the
Object/Property Management window to refresh. Look for the forms that pertain to the object
under General Tasks and Object Specific Tasks. Look for the reports that pertain to the object
under Object Specific Reports.

Seeing Performance Data in Reports

Some reports populate with data sooner than others. The first report to populate with data is
the Near Real Time report. Data begins to appear in this report after three polling cycles.
Other reports, including any report that begins with an analysis of yesterday’s performance,
will need at least one full day’s worth of data before results are viewable.

Until data has been collected for several days, the daily charts will be sparsely populated;
likewise, monthly charts will not have much to offer until data has been collected for several
months. Because the Capacity Planning report cannot function without maximum busy-hour
averages derived from data in the baseline period (42 days long), you will have to wait about
six weeks for reliable forecasting data.
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Package Removall

The New Install

If you uninstall the Interface Reporting package, the Interface Reporting ifEntry Datapipe
will be removed automatically. Uninstalling the Interface Reporting package will not affect
the Interface Discovery Datapipe.

Follow these steps to uninstall Interface Reporting 5.54:

1
2

o 0 A W

10
1

12

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
Windows:
a From the Control Panel, select Administrative Tools > Services
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Solaris: sh /etc/init.d/ovpi_timer stop
Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Uninstall.

Click Next. The Report Undeployment window opens. If the reports in Interface Reporting
were deployed from this server, accept the defaults for Undeploy Reports, Application
Server Name, and Port. Otherwise, clear the check box and skip to step 8.

Type your username and password for the PI Application Server.

Click Next. The Package Selection window opens. Click the check box next to the following
packages:

a Interface Reporting

b Interface Reporting Device

c¢ Interface Reporting Location

d Interface Reporting Protocol

e Interface Reporting Thresholds

f  Interface Reporting Vian

g Interface Reporting Demo

Click OK.

Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens and the removal process begins. When the
uninstall process is complete, a package removal complete message appears.

Click Done to return to the Management Console.
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13 Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Solaris: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System

Follow these steps when setting up a distributed system:
1 Decide whether you want local reporting or central reporting.

2 Install the right set of packages on each server (a central server that is not polling will not
need datapipes; the satellite servers will need datapipes).

Verify that the system clocks in your environment are synchronized.

Register your satellite servers.

If you are not copying rate data to the central server, enable LIR on the central server.
If you enable LIR, add LIR mapping with the time type set to rate.

Verify that you have all the copy policies you need.

Configure the central server (manual edits to trendtimer.sched and .pro files).

VO 00 N 00 0 AW

Configure each satellite server (manual edits to trendtimer.sched and .pro files).

If you want local reporting, you need to deploy reports when you install the report pack on
each satellite server, and you also need to allow summarizations to run on each satellite
server. If you do not want local reporting, then you do not need to deploy reports when you
install a report pack on a satellite server, and you can disable the scripts that run
summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone
setting up a distributed system was to deploy reports on satellite servers, keep rate data on
satellite servers, copy hourly data to the central server, and disable summarizations above the
hourly level on satellite servers. This approach had two benefits. It kept a lot of rate data off
the network, and it decreased the processing load on the central server. The problem with this
approach is that the central server could not display a Near Real Time (NRT) report. The only
NRT report was a local NRT report, on a satellite server.

LIR fixes this problem. If you enable LIR, you can open an NRT report on the central server
and drill-down on table selections. The selections you make cause the central server to query a
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the
central server, you can. If you do, then enabling LIR is not necessary.

Interface Reporting now comes with a copy policy import file. When you install Interface
Reporting, PI uses this file to generate copy policies. Creating these policies yourself, using
the Management Console, is no longer necessary. Your only task is to verify that you have the

copy policies you need. (For this report pack, you will verify that you have a copy policy for one
table only: SHIRDevPorts.)

Because you are likely to have multiple satellite servers, we designed the hourly process files
to be satellite-server friendly. This means that most of the time, most of the defaults are
correct. But some defaults will be incorrect, or less than optimal, and to improve performance,
you should change them. These manual edits, as well as the other steps listed above, are
spelled out in detail in this chapter.
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Checking for Proper Package Installation

In a distributed system, you want the following packages on the central server:

Interface Reporting 5.54
Interface_Reporting Device 5.31
Interface_Reporting_Location 5.31
Interface_Reporting_Protocol 5.31
Interface_Reporting_Vlan (optional) 5.30

In a distributed system, you want the following packages on satellite servers:

In a distributed system, you want the following datapipes on satellite servers:

Interface Reporting 5.54
Interface_Reporting_Device 5.31
Interface_Reporting_Location (optional) 5.31
Interface_Reporting_Protocol (optional) 5.31
Interface_Reporting_Vlan (optional) 5.30
Thresholds sub-package (optional)

Interface Discovery Datapipe 2.60
Interface Reporting ifEntry Datapipe 2.53
Cisco VLAN Datapipe 5.30 (optional)
OPNET Export Datapipe 2.11 (optional)
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Split Polling and Avoid Duplicate Polling

You must decide how polling will take place and then split the device groups accordingly.
These are your options for splitting device groups:

e Split polling between the central server, satellite servers, and remote pollers
e Split polling between satellite servers and remote pollers
e Split polling between multiple remote pollers

The situation you must avoid is duplicate polling, which arises when the device groups
assigned to one server happen to be the same device groups assigned to a different server, or
to a remote poller. To avoid this problem, split the polling function properly. The polling
function is split properly when:

e No two servers have the same polling policies and device group lists
e No two remote pollers have the same polling policies and device group lists
e Servers and remote pollers do not share polling policies and device group lists

For more information about polling policies and how to create them, refer to the Interface
Reporting ifEntry Datapipe User Guide.
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Configuring the Central Server

To configure the central server, perform the following tasks:

e Task 1: Register the satellite server by setting the database role

e Task 2: Enable LIR

e Task 3: Add LIR Mapping

e Task 4: Verify that you have a copy policy for the SHIRDevPorts table
e Task 5: Modify the trendtimer.sched file

Task 1:  Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.
Navigate to the PI Databases folder and select the database system.
Click Database Properties.

From the Database Role list, select the Satellite Server role.

o O A WN

Enter any information necessary to configure the Satellite Server role.

) To add a new database reference, you can use the Add Database Reference Wizard in the
System and Network Administration application.

Task 2:  Enable LIR
Enable LIR by following these steps:

1 Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.
Navigate to the PI Databases folder and select the central server.

Click LIR Configuration.
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Select the LIR enabled check box.

Task 3:  Add LIR Mapping

1 Start the Management Console (log on with Administrator privileges).

2  Click the Systems icon in the navigation pane.

3 Navigate to the PI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 Select a satellite server to which you need to add a mapping from the Select Satellite
Server list.

7 Select the Category data table option.

8 Select Interface Reporting from the drop down list.
9 Select the rate data type.
10 Click Add to List.
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1 Ensure that the LIR mapping has not missed mapping the tables.

12 If you want to add additional LIR mappings, click Add Mapping and repeat step 6 through
step 1.

13 Click OK.
14 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that
you add. The data type selected when adding an LIR mapping (in step 10 above) determines
the type of data copied (defined in the generated copy policy). The type of data copied is one
summarization level greater than the data type selected in the LIR mapping. For example, if
you select an hourly data type, you will generate a daily data copy policy.

Task 4:  Verify that you have a copy policy for the SHIRDevPorts table

Verify that a copy policy was generated for the SHIRDevPorts table and that the copy type is
set correctly:

1 Start the Management Console (log on with Administrator privileges).

2  Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.
3 Find the SHIRDevPorts table and verify the copy type is set to Property and Data.
If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy
Manager. The Copy Policy Wizard displays.

Click Next. The Satellite Server and Copy Policy Selection Page opens.

w

Select a satellite server from the pull down list. This is the satellite server from which
data is copied to the central server.

Select Single Table and select SHIRDevPorts from the pull down list.
Click Next. The Copy Type Selection Page displays.

Select Property and Data.

Click Next. The Summary page displays.
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Verify the information in the summary window. If the information is not correct, you can
modify it by clicking Back.

9  Click Finish.

If the copy type is not set to Property and Data, do the following:
1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5:  Modify the trendtimer.sched file
The trendtimer. sched file is located here:
<DPIPE _HOME>/lib/

where <DPIPE HOME> is the directory in which PI is installed. The trendtimer. sched file
runs executables in the bin directory.

1 Open the file and find this line:
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4

24:0044:00 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/IR DevPort DMF Process.pro

Modify the daily processing time; make the executable start 20 minutes sooner:
24:00+3:00+40
Find this line:

1:00+20 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/IR DevPort Hourly Process.pro

If the central server is not polling, comment out this line.

Configuring a Satellite Server

Follow these steps to configure a satellite server.

1

Modify the trendtimer. sched file. Navigate to:

<DPIPE _HOME>/lib/

where <DPIPE HOME> is the directory in which PI is installed.
a Open the file and find the following line:

24:00+4:00 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/IR DevPort DMF Process.pro

b Make the process start sooner by modifying the processing time:

24:00+3:00+40- - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/IR DevPort DMF Process.pro

Disable the daily, monthly, and forecast summarizations by editing the
IR DevPort DMF Process.pro file. Navigate to:

<DPIPE HOME>/scripts/

where <DPIPE HOME> is the directory in which PI is installed.
Open the file, locate the IR DMF1 block, make these edits:

e Comment out the begin:IR DMF1 wait line

e Comment out the end:IR DMF1 line

The lines in the IR DMFO block are okay, do not edit them.

Use Table Manager to reduce the retention period of the SHIRDevPorts table from 4 days
to 2 days. (Keeping data for 4 days is no longer necessary.)

Configure any protocols that should not be monitored to unmonitored.

Verify proper configuration of polling policies. Verify that each node is polled from one
system only. Follow these guidelines:

e Ifyou are using remote pollers, avoid duplicate polling by remote pollers, and
duplicate polling by the satellite server and remote pollers.

e If asatellite server has two or more remote pollers, create separate polling policies for
each poller and use view groups to separate the devices.

e Each poller must have 13 polling policies associated with it:
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— 1 for the RIRRouterSystem table
— 8 for the Interface Discovery Datapipe
— 4 for the Interface Reporting ifEntry Datapipe

Polling policy configuration is automatic. Unless you have remote pollers, no additional
configuration is necessary. If you need help configuring polling policies, refer to the Interface
Reporting ifEntry Datapipe User Guide. See Chapter 3, Datapipe Configuration.

Synchronizing System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock
on the central server.

Synchronizing Property Data Between Central Server and
Satellite Servers

To synchronize the property data between the central server and satellite server, the Interface
Reporting report pack uses .pro files that export and import property data. Follow these
steps to synchonize the data:

1 Run IR exportdata.pro on the source server (central or satellite) to generate the
IR Property.dat file.

The source server is the server from which the data needs to be synchronized.

2 Copy the IR Property.dat file to the destination server (central or satellite) server.
Copy the file in a directory from where ee collect can pick it.

3  Runthe IR import.pl script. This script updates the IR interface customer/location
reference based on node’s customer/location reference. To run the script, type

perl IR import.pl -o <value>
The <value> can be:
1 If you use this option, IR import.pl overwrites the existing relation and

updates all the interfaces with the customer and location information of the
nodes irrespective of assigned, unassigned, or imported interfaces.

2 If you use this option, IR import.pl updates the interfaces that are not
assigned with a customer and location to reflect the customer and location of
the node.

3 If you use this option, IR _import.pl updates all the imported interfaces with

customer and location reference of the node.
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5 Importing Properties

Static Property Information

Interface Reporting has the ability to store and process static property information as well as
rapidly changing performance data. Following is an alphabetical list of the properties that
may appear in reports:

e Country

e Customer

¢ Description

¢ Device Name

e Device Type

e Discard Threshold

e Error Threshold

e Full or Half Duplex

e  Group ID

e  Group Name

e ifAlias

e ifAdminStatus

e Interface Description
e Interface Speed

e Interface Speed In

e Interface Speed Out
e Interface Type

¢ Location ID

¢ Location Name

e Model Details

e Model Number

e Protocol

e Utilization Threshold
¢ Vendor Details

¢ Vendor Name
Property information comes from the following sources:

e Protocol Configuration Table (update this using a form)
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e Automatic feed from the network
e Common Property Tables batch-mode property import
e Common Property Tables “add new” and “update” forms
e Interface Reporting batch-mode property import
¢ Interface Reporting change forms:
— Change Protocol Defaults
— Update Interface
— Change Interface Customer
— Change Interface Description
— Administer Interface Poll Flag
— Administration (Logging, Data Filtering, Provisioning)

Node-level properties and interface-level properties have different sources. Common Property
Tables is the source for node-level properties. The change forms that come with Interface
Reporting, and the batch-mode import that comes with Interface Reporting, are sources for
interface-level properties.

If there is a customer and a location associated with a device, use Common Property Tables to
assign the device to that customer and location. Once that step is done, interface-level
properties will be inherited from the node level. For example, if you use Common Property
Tables to assign a device to a customer, and then you import additional properties using the
batch-mode property import that comes with Interface Reporting, any “unassigned interfaces”
(interfaces not explicitly assigned to a customer) in your import file will automatically inherit
the node-level customer.

When an interface is discovered, various attributes associated with that interface (speed, type
and description) are sourced from the network. However, attributes sourced from the network
are not always correct. The following properties may be incorrect:

e ifType
e ifSpeed
e ifDescr

To correct a property that is incorrect, you can either update a property import file, then
import the file, or you can open a form, modify the contents of the form, and save your
changes.

If you set the Provisioning Mode to option 1, the property import file will not overwrite values
for ifT'ype, ifSpeed, and ifDescr that were sourced from the network. For details, see the
section about Provisioning Mode options in Chapter 7, Change Forms.
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Protocol-Specific Monitoring

The monitoring status parameter allows you to enable or disable interface monitoring based
on the protocol. By default, all active (administratively up) interfaces with monitored
protocols are polled, and all the polled data is stored, summarized, and reported. You can
configure PI to disable collection for certain protocols. For example, if a device has ATM ports
and frame relay ports and you are not interested in the frame relay ports, you can disable
collection for the frame relay ports.

Switching off monitoring of a previously monitored protocol does not remove data from the
database, but switching off monitoring will prevent new data for that protocol from being
collected or inserted. If you switch off monitoring of a previously monitored protocol,
previously collected data will eventually age out. To find out whether any interface data is
being deliberately ignored as the result of marking a protocol unmonitored, look at the
Configuration and Logging report in the Admin folder.

For information about polling rules and how to stop the system from collecting data for ports
with unmonitored protocols, refer to the Interface Reporting ifEntry Datapipe User Guide.
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Batch-Mode Property Import

The purpose of the property data interface is to import property data into PI as a batch
process and export property data from PI as a batch process. Batch mode would typically be
used instead of forms when large numbers of interfaces need to be updated.

When PI imports property data, the file that gets imported needs to adhere to a particular
format; when PI exports property data, the file it produces is already in the proper format for
you to modify and re-import. You can create an import file by:

¢ Building it from scratch using a spreadsheet application
e Exporting the required data, in the required format, from your provisioning database
e Letting PI collect property data, then exporting this data from PI

Since building a property import file from scratch is not easy, we recommend that you follow
these steps:

1 Add devices to the system.
2 Allow the system to discover the interfaces on those devices.
3 Export existing property data from PI by typing this command:
trend_proc -f IR exportdata.pro
4 Use the results as a starting point for your own modified property import file.

Store your modified file in the correct directory (where PI expects to find it) and import
the file by typing this command:

<DPIPE_HOME?>/bin/perl <DPIPE_HOME>/bin/IR_import.pl -o <value>

For information on <value>, see Synchronizing Property Data Between Central Server
and Satellite Servers on page 43.

) IR importdata.pro has been replaced with IR import.pl in the IR Report
Pack version 5.54.

The import command will import data from—and the export command will export data to—
the following directory:

<DPIPE_HOME>/data/PropertyData
where <DPIPE HOME> is the directory in which PI is installed.

) When the number of interfaces is high, the export procedure might take longer to run.
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Property Import File

The following table describes the format of the property file. If you are creating this file
yourself, make sure that your file adhere to this format. Your sequence of fields left to right
must follow this sequence of attributes top to bottom and your attributes must be delimited by
tabs, not spaces. If you are exporting this file from PI, the format will be correct.

Attribute

Type

Default

Description

Device

char_string,
64

N/A

Name of the device. A value for this
attribute is required.

Interface

char_string,
128

N/A

A unique identifier for the
interface. A value for this attribute
is required.

full_half

integer

Denotes half duplex or full duplex:
1 =half duplex

2 = full duplex

Automatically populated from the

Protocol Configuration Table if the

value is NULL. Not automatically
overwritten unless set to NULL.

ifAdminStatus

integer

N/A

Denotes the state of the controller
in the software configuration;
whether it is up or down

Valid values are :
1=up

2 = down

3 = testing

ifAlias

char_string,
255

N/A

Refers to an
administrator-assigned name for
an interface on a network device
such as a switch or router.

ifType

integer

N/A

The ifType as given by the ifTable
on the managed device. Used as a
cross-reference into the Protocol
Configuration Table to determine
the protocol and its properties.

ifSpeed

gauge

N/A

The ifSpeed as given by the ifTable
on the managed device.

ifSpeedIn

gauge

N/A

The ifSpeed as given by the ifTable
on the managed device. Can be
changed to reflect the inbound
speed on a dual speed interface.
Used only for full-duplex
interfaces.

Importing Properties
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Attribute Type Default Description
ifSpeedOut gauge N/A The ifSpeed as given by the ifTable
on the managed device. Can be
changed to reflect the outbound
speed on a dual speed interface.
Used only for full-duplex
interfaces.
ifDescr char_string, N/A The ifDescr as reported in the
255 ifTable.
cust_id seq_key -2 The customer identifier used to
group interfaces by associated
customer.
customer_name char_string, “Unknown | The customer name used to group
198 Customer” | interfaces by associated customer.
group_id seq_key -2 The group identifier for this
interface. Not used explicitly.
group_name char_string, “Unknown | The group name for this interface.
128 Group” Not used explicitly.
location_id seq_key -2 The location identifier used to
group interfaces by physical
location.
location_name char_string, “Unknown | The location name used to group
128 Location” interfaces by physical location.
country_code seq_key -2 The country code for this interface.
Not used explicitly.
country_name char_string,12 | “Unknown | The country name for this
8 Country” interface. Not used explicitly.
UtilThreshold integer 10000 Utilization threshold. A percentage

of available bandwidth, calculated
as an average over the polling
interval. Will auto-update from the
Protocol Configuration Table only
when this value is defaulted to
10000 and the KIR_protocol_config
value is > 0.
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Attribute Type Default Description

ErrorThreshold integer 10000 Error threshold. Percentage of
traffic with errors, calculated as an
average over the polling interval.
Will auto-update from the Protocol
Configuration Table when the
value is defaulted to 10000 and the
KIR_protocol_config value is > 0.

DiscardThreshold integer 10000 Discard threshold. Percentage of
traffic with discards, calculated as
an average over the polling
interval, at which an exception is
counted.

Will auto-update from the Protocol
Configuration Table only when this
value is at the default of 10000 and
the KIR_protocol_config value is >
0.

AvailabilityThreshold | integer 98 Availability threshold. A
percentage of availability,
calculated as an average over the
polling interval, at which an
exception is counted.

Will auto-update from the Protocol
Configuration Table only when this
value is at the default of 10000 and
the KIR_protocol_config value is >
0.

Changing the Default Directory for PropertyData

The default directory for data property files, the location where the import utility will look for
your edited files, is specified by the SourceDirectory path. This path appears in the following
TEEL file:

IR Property.teel

If you change the default directory before you install the Interface Reporting package, your
task is easier, since you only have to change the path once, by finding the TEEL files in the
Interface_Reporting.ap directory. If you want to change the default directory after installing
Interface Reporting, you must make the path change in two places, namely:

¢ Interface Reporting.ap
e <DPIPE HOME>/1ib

Changing the location of the PropertyData directory is not recommended. However, if you
needed to change the directory location, follow these steps:

1 Create the new source directory.

2 Navigate to the appropriate directory (see the discussion above regarding which
directories are involved) and open the directory.
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3 Edit this file: IR Property.teel

¢ Locate the SourceDirectory default path; look for the line beginning with
SourceDirectory =

¢ Change the path, replacing the existing path with the complete path name to the new

directory; begin the new path name just after the equal sign ( =).

) Leave the file filter as specified in the original SourceDirectory.

Adding Details about Vendors and Models

The Devices sub-package can recognize vendors and models based on the sysObjectld. You can
add or modify the list using an import procedure that is similar to interface provisioning.
Vendor details are stored in the following files inside the

Interface Reporting Device.ap directory:

® vendor.txt
® vendor model.txt
Add rows, or modify existing rows, and then call this process:

trend proc -f IR Import Vendor.pro

Vendor Properties

The following table provides a list of the available fields.

Column Type Default Comments

Vendor Name char_string,128 Required Field | The name of the vendor.
Example: “Cisco”

Vendor Details char_string,128 Required Field | Additional details about all
equipment from this vendor.
Example: “Cisco Inventory”

Vendor sysObjectld | char_string,128 Required Field | The SNMP sysObjectld from
the system group on the
device.
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Model Properties

The following table provides a list of the available fields.

Column Type Default Comments

Vendor Name char_string,128 Required Field | The vendor name.

Model Details char_string,128 Required Field | Additional details about this
model.

Model sysObjectld | char_string,128 Required Field | The SNMP sysObjectld from

the system group on the
device.

Importing Properties
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6 Archiving Data

Data Archiving

The data archiving feature allows you to store large amounts of data in archive tables without
affecting the summarization and reporting performance of PI.

By default, archiving is disabled. When archiving is enabled, a data table becomes an active
data table. Data is retained in the active table for a specified amount of time (defined in the
retention profile) before it is moved to an archive table. An active table can archive data to one
and only one archive table.

Active

Data

/
Enable Table
Archiving
Data /
Table
Archive
Data
Table

) Data from an active table and data from an archive table cannot be displayed in the same
report.

When you installed the report pack, a retention profile was created for each data table (using
information from the TEEL file). The retention profile defines the name and description of the
retention profile, how long (in days) data remains in the active data table, how long (in days)
data remains in the archive table, and if archiving is enabled. You enable archiving of a data
table by modifying its retention profile. A retention profile can be assigned to more than one
data table, but a data table can only have one retention profile assigned to it.

For more detailed information about data archiving, refer to the HP Software Performance
Insight Administration Guide.
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View Current Retention Profiles List

To view all retention profiles:

1
2

Start the Management Console (log on with Administrator privileges).

Click the Tables icon in the navigation pane to display the Table Manager navigation
pane.

Select File->Retention Profiles->Manage Retention Profiles. The Manage Retention Profiles
dialog displays the current retention profiles list. You can create, modify, and remove
retention profiles from the Manage Retention Profiles dialog.

) You cannot modify the default profiles created during the product installation, remove a
default profile, nor remove a profile that is in use.

Enable Archiving

To enable archiving, either select a data table to modify its retention profile or modify a
retention profile. A table has archiving enabled if the Archive On check box is selected in the
Table Manager navigation pane.

Selecting a Data Table to Modify

To modify the retention profile of a selected table, do the following:

1

o 0 A W

From the Management Console, click the Tables icon in the navigation pane to display the
Table Manager navigation pane.

In the Table Manager navigation pane, double-click a table. The Data Table Details dialog
displays.

Select the Retention Profile tab.
Modify any of the fields in the dialog.
Select the Archive On check box.
Click OK.

Modifying the Retention Profile

To modify a retention table, do the following:

) You cannot modify the default retention profiles created during the report pack installation.

From the Management Console, click the Tables icon in the navigation pane.

Select File->Retention Profiles->Manage Retention Profiles. The Manage Retention Profiles
dialog displays.

Select the retention profile to modify and click Edit.
Modify any of the fields in the dialog.
Select Yes in the Enable Archiving field and then click OK.

Chapter 6



Create a Custom Retention Profile

To create a custom retention profile and assign it to a active data table, do the following:
1 From the Management Console, click the Tables icon in the navigation pane.

2  Select File->Retention Profiles->Manage Retention Profiles. The Manage Retention Profiles
dialog displays.

3 Click Create. The Create Retention Profile dialog displays.

4 Enter the following information:

Field Description
Profile Name The name of the retention profile. Maximum length is 64
characters.

Retention Days The number of days to retain data in the active data
table before moving the data to the archive data table.
Select Yes for the permanently field if you want to retain
all data in the active data table (do not move any data to
the archive data table).

Archive The number of days to retain data in the archive data
Retention Days table before the data is removed. Select Yes for the
permanently field if you want to retain all data in the
archive data table (do not remove any data from the
archive data table).

Description A description of the retention profile. Maximum length is
255 characters.

Enable Default: No. Select Yes to enable archiving and create
Archiving? the active and archive data tables.

5 Click OK.
6  Assign the custom retention profile to a table:
a From the Management Console, click the Tables icon in the navigation pane.

b  To filter the tables listed, you can select a specific category (such as
Interface_Reporting) and/or a specific type (such as Rate) from the pull down lists
above the list of tables.

¢ Select the table(s) to which you want to assign the retention profile

d Select File->Retention Profiles->Assign Retention Profile. The View Retention Profiles
dialog displays.

e Select the retention profile you created.

f  Click Assign Retention Profile.
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View Archive Data Reports

Archive data reports are viewable anywhere active data reports are viewable (archiving must
be enabled and there must be data in the archive data tables before you can view archive data
reports). From the Web Access Server, the reports are available in the Archive folder.

) Data from an active table and data from an archive table cannot be displayed in the same
report.
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7 Change Forms

Interface Reporting includes multiple change forms. Use these forms to modify:
¢ Protocol defaults

¢ Interface speed and associated thresholds

e (Customer, location, and interface description

¢ Directed-instance polling

¢ Logging level

e Data filtering

¢ Provisioning mode

Keep in mind that you cannot assign interfaces to customers or locations that are not already
recognized by Common Property Tables. To add customers and locations to Common Property
Tables, use the Create New Customer or Create New Location forms, or use the batch-mode
property import that comes with Common Property Tables. For details, refer to the Common
Property Tables User Guide.

Changing Protocol Defaults

If you have not pre-provisioned new interfaces to configure specific thresholds and indicate
whether they are full or half duplex, values for those variables will be pulled from the protocol
configuration file as new interfaces are discovered and added to the system. You can add a
new protocol to this file or you can modify the characteristics of an existing protocol.

Follow these steps to change the monitoring status or the default protocol thresholds:
1 Select Start > HP Software > Performance Insight > Management Console.

2 Click Objects and select any managed object. Forms appear under General Tasks.
3 Double-click Change Protocol Defaults. The form opens.
4

Select the protocol you want to change, then update Protocol Name, Monitor status, or
Threshold percentage values as required.

5 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the
form without saving changes.

The system will use defaults from the protocol table when:
e A just-discovered interface is inserted into the interface property table

e An existing interface has NULL values for protocol-related properties
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An existing interface has NULL values for protocol-related properties

[f| /admin/Interface_Reporting_Forms,/change_protocol_defaults =10 x|
Interface Reporting (ﬁB
Change Protocol Defaults invent

LIze this form to change the default settings for Protocols {interface types) for the Interface Reporing
report pack. You can change the names for Unknown protocols, and modify the default duplex and
threshald settings for each protoocal. The system can be configured to naot poll interface types that
have the Manitar lag set to OF (0). Selectthe Protocol yau want ta change the settings far, and then
enter the new settings below. Click the Apply button to save any changes. Click the Cancel button to
cancel any changes. Clickthe Ok button to save changes and close the form.

Default Default Del
ifType Protocol Hame Duplex Monitor  Wilization Discard Er
Threshold Threshold Thre
1 other 2 1 a0.00 1.00 il
2 regularigzz z 1 Q0.0 2.00 .
] hdh1g22 2 1 o0.00 2.00 p:
4 ddn-x28 z 1 Q0.00 2.00 p:
] fear 7 -x2a z 1 Q0.00 z.00 b
=] ethermnet-cemacd 1 1 20.00 1.00 &
7 is0@2023-csmacd 1 1 Q0.00 2.00 p:
g iso-B802<tokenBus 1 1 &0.00 z.00 .
] is0-88025-tokenRing 1 1 &0.00 2.00 :
10 is0@2026-man 2 1 o0.00 2.00 i
44 el A bl A4 [ainMalnl e Biulnl L
4 e
Protocol Name ethernet-csmacd Monitor Monitor ll
Litilization Threshold Error Threshold Discard Threshold
Thresholds 30,00 |1.uu 1.00
(o] | Apply Cancel
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Changing Interface Properties

Change Forms

You can use the Change Interface Properties form to modify the following properties:

Customer assignment
Location assignment
Utilization threshold
Error thresholds
Discard threshold
Availability threshold
Speed [In/Out]

This form is especially helpful when you want to change multiple properties for a single
interface, or when you want to update multiple interfaces on a single device. If desired, you
may use the Change Interface Properties form to update all the interfaces on one device in
one operation; however, don’t forget that every interface will be updated to the same set of
values, including speed and threshold settings. To access the form:

1
2

Select HP Software > Performance Insight > Management Console.

Click Objects, then navigate to and select the interface you want to update. Or, to update
all the interfaces on a device, select the device. You will see Change Interface Properties
listed under Object Specific Tasks.

Double-click Change Interface Properties. The form opens.

Select an interface, then update assignments, thresholds, speeds, or duplex values as
required.

Click Apply to save changes, OK to save changes and close the form, or Cancel to close the
form without saving changes.
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| fadmin/Interface_Reporting_Forms; nge_interface.frep

Update Interface e n
I,

Thig form allows interface information to be updated. Select the intefacels) vou want te change, and update the propery values. Click the Apply

button to save any changes. Click the Cancel button to cancel any changes. Click the OK button to save any changes and close the form.

Device Interface ifindex Description Speed Protocol Cus
routerz BRIO 2.00 BRIO In: 16.0 Kbtz Out: 16.0 Khis lapd =2
router2 ERID-Physical .00 ERID-FPhysical In: 144.0 Khis Out: 1440 Khis izdnu
router2 BRIO-Signaling .00 BRIO-Signaling In: 16.0 Kbz Ot 16.0 Khis izdn
routerz BRIO: .00 BRID: I 4.0 Khiz Out: 640 Khis PRP
routerz BRIO:1-Bearer Channel 10.00 BRIO:1-Bearer Channal In: G40 Khvs Cut: 54.0 Khis d=0
routerz BRIO:Z 4.00 BRIO:Z In: 64.0 Kbtz Out: 64 .0 Khis )
routerz BRIO:Z-Bearer Channel 141.00 BRIO:Z-Bearer Channeal In: 54.0 Khvs Out: 54.0 Kbz ds0
routerz FastEthernetd 5.00 FastEthemetd 100.0 Mkvi= ethermet csmacd
router2 Hulld 5.00 Hullo In: 4.3 Ghis Out: 4.3 Ghis ather
routerz Seriald 1.00 Seriald In: 1.5 Mhds Out: 1.5 Mbis frameRelay i

jllim’? Sarialn 1 Fnn Sariall 1 I 1 & hibois Cnat 15 hibis frameR&la _ILI
4 »

Description ISeriaIEI

Customer IHp - | Location IWashingtDn - |

Thresholds Litilization % Error % Discard % Availability %

Thresholds define ITD a0 |1 i} |1 i} Iga a0

the levels where

[ ={PEN Fimme arn

Speed Speed (hps) Speed In (bps) Speed Out (hps)

Interface spead |1 544,000 |1 544,000 |1 544,000 Duplex IFuII - I

initially sat from

netar,

‘Warning: When you press OK or Apply, all the settings abowve will be applied to all selected intedfaces.

Ol | Apply | Cancel
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Changing Customer and Location

Change Forms

The Change Interface Customer and Change Interface Location forms allow you to assign
interfaces to a customer or a location. These forms can be used to update a single interface, or
to assign all the interfaces on a device to single customer or location.

To change the customer or location assignments, follow these steps:

1
2

Select HP Software > Performance Insight > Management Console.

Click Objects, then navigate to the interface you want to update, and select it. You may
also select a device, if you want to update all the interfaces on that device. The forms
appear under Object Specific Tasks.

Double-click Change Interface Customer or Change Interface Location. The form opens.

Use the selection list to update the assignment.

Click Apply to save changes, OK to save changes and close the form, or Cancel to close the
form without saving changes.

[ /admin/Interface_Reporting_Forms,chan - |EI|E|

Interface Reporting [ﬁB

Update Interface Customer

invent

This form allowes inteface customer assignments to be updated. Select the
Customer for the interfacels) from the drop-down list. Click the Apply button to save
amy changes. Click the Cancel button to cancel any changes. Click the OK button
to save any changes and close the form.

Customer HF -

Miarning: When you press OK or Apply, all the settings abowe will be applied to
all selected interfaces. If you opened this Form for a Device, the same values
will be applied to all interfaces. Fress Cancel if you do notwant to apply the
same walues to all.

K, apply Cancel
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Changing the Interface Description

If you want to change the description of an interface, follow these steps:

1
2
3

[ /admin/Interface_Reporting_Forms,/change_interface_descr.fr - |EI|5|
Update Interface Description Cnvent
This form allows the interface Description to be updated. Click the Apply button to =ave any changes. Click the
Cancel button to cancel any changes. Click the OK button to zave any changes and close the form.

Device Interface Description Protocol Speed
routeri FastEthermetim F astEthermetim ethemet-csmacd 100.0 Mbv's
router Hullo Hulld other 4.3 Ghis
routerd Serialdi Serialdi frameRelay 1.5 hibis
routerd Serialdin.40 Atlanta frameRelay 1.5 Mbis
routeri Serialdio. Seriallin.a frameRelay 1.5 Mhis

Description atlanta
Warning: When you press 0K or Apply, all the settings abowe will be applied to all selected intefaces

Select HP Software > Performance Insight > Management Console.
Click Objects.

Navigate to the interface you want to update, or the device for which you want to update
one or more interfaces. The Change Interface Description form is listed under Object
Specific Tasks.

Double-click Update Interface Description. The form opens.
Select the interface you want to change, then update the description as required.

If you selected a device and opened this form, all the interfaces on the device will appear
in the table. You can update the descriptions for multiple interfaces by selecting one,
updating the description and clicking Apply, and then repeating.

Click Apply to save changes, OK to save changes and close the form, or Cancel to close the
form without saving changes.

0] 4 apply Cancel
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Configuring Directed-Instance Polling

Change Forms

The Interface Reporting ifEntry Datapipe supports five polling rules. One of the supported

rules, Poll Flagged Interfaces Only, permits collection from selected interfaces only, namely,

interfaces that have a poll flag set. There are several methods to set the interface poll flag.

One method is to use the Administer Interface Poll Flag form.

Follow these steps to set the interface poll flag using the Administer Interface Poll Flag form:

1 Select HP Software > Performance Insight > Management Console.

2 Click Objects.

3 Navigate to the device you want to update and select it. The Administer Interface Poll

Flag form appears under Object Specific Tasks.

4 Double-click Administer Interface Poll Flag. The form opens.

[| /admin/Interface_Reporting_Forms,/set_poll_flag_param.frep

Interface Reporting

Administer Interface Poll Flag

=101 x|

O

inwvent

Select Device router]

se this form to update the Poll Flag for the Interface Reporting report pack. Ifthe "Poll Flagged
Interfaces Onl" polling rule is enabled, the datapipe only collects ifEntry data for interfaces that have
the ifEntry Poll Flag setto On (1), Select the device yvou swant to update {or start typing the device
name), then select the interface or interfaces you want to change the setting for, and then selectthe
new Poll Flag setting. Click the Apply buttan to save any changes. Click the Cancel button to cancel
any changes. Clickthe QK hutton to save changes and close the form.

|

Then Select Interface(s) to be Updated

Interface ifindex ifType g:’ar::'; Speed ifEntry Poll Flag
Serialom 1 3z 1 1.5 Mz 1]
Ethernet0io z a] z 1000 Mits u]
Ethernetdi 3 5] 2 1000 Mtz u]
FastEthernet1/0 4 5] 1 100.0 M n]
Hullo 5 1 1 4.3 Ghiz ]
Serial0n .40 ] 3z 1 1.5 Mz ]
Serialom. 41 7 3z 1 1.5 Mz o

Set Poll Flag of v
(0] 4 | Appl o ncel

65



5 Select the interfaces you want to change, then update the description as required. You can
select multiple interfaces by using the CTRL or SHIFT keys.

6 Select the required poll flag setting, On or Off.

7 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the
form without saving changes.

Data Filtering, Provisioning, Logging, and Gather Stat Level

Data Filtering

Option

Impact

0

The default. Data for all collected interfaces is transferred
from the datapipe to the report pack. If new devices or
interfaces are discovered and polled, property rows for those
devices and interfaces will be added in the report pack.

Only data for provisioned interfaces will be transferred to
the report pack. Data collected for interfaces that are not
already provisioned in the report pack will be discarded.

Provisioning Mode

Option

Impact

0

The default. Values for Interface Speed, Type, and
Description collected from the network do not overwrite
provisioned settings. If a new interface is discovered, and
this interface is not provisioned in the report pack, these
attributes are set once from collected data.

Values for Interface Speed, Type, and Description collected
from the network overwrite provisioned settings. If you use
property import to import values, ifSpeed, ifType, and
ifDescr will not be updated.

Logging Level

Option Impact

0 Errors only

1 The default. Standard level of logging.
2 Maximum level of logging.
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Gather Stat level

Option Impact

0

To disable Oracle’s Gather Stat utility during data collection

1

To enable Oracle’s Gather Stat utility during data collection

Changing Settings

Change Forms

To change settings for data filtering, provisioning, or logging level follow these steps:

1
2

Select HP Software — Performance Insight — Management Console.

Click Objects and select any managed object. Forms will appear in the General Tasks
window.

Double-click Administer Interface Reporting. The form opens.
Select the administration setting you want to change, then select the new setting.

Click Apply to save changes, OK to save changes and close the form, or Cancel to close the
form without saving changes.
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Interface Reporting

Administration

[

invent

Use this form to update the Prowisioning, Da

and close the form.
Logging : The number and detail of m
0 = high lewel anly, 1 = infan

[rata Filtering : Create new interfaces in the
0="res, 1= Ho

0 = Only owenwrite if current

Gather Stat : Enable Oracle's Gather stats
0 = Disable &ather Stat, 1=

Configuration
Logoing Lervel
Data Filtering

Provizioning
Gather Stat

Change setting

ta Filtering and Logging settings for Inteface Repording. Select the

Configuration setting ywou want to change and enter the new walue in the Change setting box below. Click the Apply
button to sawe any changes. Click the Cancel button to cancel any changes. Click the OK button to save changes

eszages sent to the

Configuration and Logging Report.

mational, 2 = all f debug

Report Fack property tables as they are discowered during polling™

Frovisioning : Determines whether Property values for inteface Speed,
Type and Description will be ovenvitten by collected walues.

is not set (NULL),

1 = Always owenurite from collected data

during collection
Enable Gather Stat

Value Meaning
2 Max Logging
1 Do Mot Add Mewy Interfaces
0 Updste Cnly If Mot Set
1 Gather Stat is running in IR_map_p

1 <]

2 - Max Logaing

oK | Apply |

Cancel

The Gather Stat Configuration parameter will not appear in the IR_admin form if you are

using Sybase.
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8 Spotting High Exceptions

Interface Reporting provides five reports that help you focus on high exception counts:
e Exception Hot Spots (Exceptions sub-folder)

e Device Exception Hots Spots (Device folder)

¢ Trunk Exception Hot Spots (VLAN folder)

e VLAN Exception Hots Spots (VLAN folder)

e EtherChannel Exception Hot Spots (EtherChannel folder)

The Exceptions Hot Spots sorts interfaces by exception count, highest to lowest. The selection
table is followed by three graphs:

e Exception counts (hourly / daily / monthly)
e For each exception type, the average, maximum, and threshold for the previous 30 days
e Daily averages for each exception type, for each traffic direction

The first graph will tell you whether the exception activity is relatively static, caused by one
type of exception, or variable, caused by multiple types of exceptions. The second graph makes
it easy to compare exception activity to the threshold. The third graph looks at utilization,
discard, and error exceptions as a percentage of available bandwidth. When the interface is
full duplex, you can view data for inbound traffic and data for outbound traffic.

The device version of the report is similar. It sorts initially by customer, then by device, and
aggregates data at the device level. Use this report to identify the devices that are generating
the most exceptions. The selection table is followed by three graphs:

e Exception counts (hourly / daily / monthly)

e For each exception type, the average, maximum, and threshold for the previous 30 days
e Daily averages by exception type

Samples of the following reports follow:

e Exception Hot Spots

e Device Hots Spots

e Trunk Exception Hot Spots
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Interface Reporting (ﬂ/n

Exception Hot Spots invent

This report has one entry for each monitored inteface that experienced threshold exceptions yesterday, An exception occurs when
inbound or outbound utilization, % discard rate or % eror rate exceeds the threshold set for that intedface. U = Wilization, D=
Discards, E = Errors. FAH indicates full or half Duplesx:.

Interfaces with Exceptions Yesterday
Sorted by Exception Count

Device Interface FH Speed Customer Tu‘ta_l Threshol
Exceptions %
16.140.11.216  =e0 H 10.0 Mbis HF o6 U300 D1 B
16.27.0.180 me1 H 10.0 Mbss  Customer Unassigned a5 L300 L E
15.144.195.0 1 H 10.0 Mbss Customer Unassigned a5 Uz=0 b
15.17.191.48 16777221 H 10.0 Mbés Customer Unassigned o6 U0 2k
16.7.208.117 1 H 10.0 Mbss Customer Unassigned a5 L=0 b E
156 .62 32 265 1 H 10.0 Mbss Customer Unassigned a5 L=0 b E
15.140.11 .63 Seriald F In: 1.5 Mbis Out: 1.5 Mbis  Customer Unassigned In:8d Out:g4 Lo b E
15.140.11 .63 Seriald. F In: 1.5 Mbis Out: 1.5 Mbis  Customer Unassigned In:8d Out:g4 Lo b E
16.3.208.119 =c0 H 10.0 Mbss Customer Unassigned bals} Uz=0 b Ev
ild}-’- T R el (5} AN N kAR~ r‘nl—lnmnrll nnnnnnn - A 11-2n ni'—l

Haurly  Daily | porthiy | Utiization Discards | Encrs |
Exception Counts for 15.27.0.190: me1 % Discard Rate for 15.27.0.190: me1
% of Actual Traffic Discarded
ooy,
- ] Ta
got] [ " [
n m Eaed
E 2
o BO I
5 S 4z |
i 40 E !
g :E 28 M |
= =
20 E14
®
1} 1]
Sun 00:00 Mon 00:00 Tue 00:00  Thu 00:00 Maon 12:00 A Tue 12200 AM Wed 12:00 Ah
M Utilization Exceptions  Mlax Discard Rate (H)
Ooiscard Exzeptions Ay Discard Rate (H)
.ErrorExceptions — DiszardThreshald

inbound | outbound | Both (Half Duplex Oy |

Average Inbound Utilization, Discards and Errors for 15.27.0.190: me1
% of Available Bandwidth

— Ao Utilization
HAorg Discards
— Ang Errars

% of Available Bandwidth

Sat12:00 AM Sun 12:00 A Mon 12:00 Aht Tue 12:00 A Wed 12:00 AM
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Interface Reporting (ﬁﬁ]

Exception Hot Spots Trunks invent

Thiz report has one entry for each monitored interface that experienced threshold exceptions yesterday. An exception occurswhen
inbound or outbound utilization, % dizcard rate or % ermor rate exceeds the threshold set for that interface. U= Uilization, D =
Dizcards, E = Errors. F/H indicates full or half Duplex.

Interfaces with Exceptions Yesterday

Sorted by Exception Count
. Total Thresholds s
Device Interface FH Speed Customer Exceptions u, Description
15214428 1M H 100.0 Mbfz  Customer Unassigned a4 20 0:1 E:1 utp fast ethemet (cat &)
16219427 412 H 100.0 Mbds  Customer Unassigned rri 30 01 EA 10M00 utp ethernet (oat 3450
| |
Hourly Dty | wonthiy | Utiization  Discards | Errars |
Exception Counts for 15.2.144.28: 11 % Discard Rate for 15.2.144.28: 11
% of Actual Traffic Discarded
100
a0
a0 L]
n 240
N i—
o B0 ) ..
§ 30 ¥
di =
E 40 H:E 20
= o
= —
20 G0
£
g .
Wyed 02:00 Thu 02:00 Wyed 12:00 P Thu 12:00 P Fri12:00 PM
M utilization Exceptions — Mlax Discard Rate (H)
Opiscard Exceptions Porg Discard Rate (H)
.EnorExceptions — Discard Threshald

inbaund | outbound | Beth (Half Duplex Only? |

Average Inbound Wilization, Discards and Errors for 15.2.144.28: 11
% of Available Bandwicth

=
=

=

E

) — Awg Wilization
fun]

o Aorg Discards
E — Awg Errors

E

k]

3
Wyed 12:00 PM Thu 12:00 At Thu 12:00 P Fri12:00 At Fri12:00 P

Spotting High Exceptions
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Q Exceptions by Type

Interface Reporting looks at exceptions in two ways, by count and by type. You can look for
interfaces and devices with the highest exception counts for yesterday, or you can look for
interfaces that produced a particular type of exception. If the exception count is what
interests you, use the Hot Spots reports. If the type of exception is what interests you, you
have three choices:

e Discard Exceptions

e Error Exceptions

e Utilization Exceptions

The format for all three reports is similar:

e Selection table that ranks interfaces by exception count

e Bar chart showing total exceptions (hourly/ daily/ monthly)
¢ Line graph comparing maximum, average, and threshold

e List of recent maximum rates, with date and time stamp

The selection table looks at yesterday’s activity and shows the exception count, the speed of
the interface, and threshold setting for each type of exception. (Threshold values are set to
defaults; these values can be changed by modifying a form or by importing a property file that
contains updated threshold values.)

The first graph tracks exception counts; the hourly graph covers the previous two days, while
the daily graph covers the previous 30 days. If yesterday’s exception count seems abnormal,
compare it to the daily graph to get a sense of what has been normal in the past. The second
graph allows you to compare average and maximum values to the threshold.

Below the graphs is a list of recent maximum rates, date stamped so that you know exactly
when the maximum was recorded. Use this list to compare yesterday’s total to previous totals
and to see whether the maximum rate has been occurring at the same time of day.
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Interface Reporting

Discard Exceptions

[

invent

Thiz report has one entry far @ach monitored inteface that experienced discard exceptions vesterday. An exception occurswhen
inbound or outbound dizcard traffic (with rezpect to total traffic) excesds the threshold set for that individual interface. FfH indicates
full ar half Doples.

Interfaces with Discard Exceptions Yesterday
Sorted by Exception Count

Hourly | Daiy | Morthy |

(X5}

# Exceptions
[ (]

Exceptions for 15.27.0.190: me1

0
hdan 00:00

Mon 15:00 Tue 06:00 Tue 21:00
Time

O rotal Exceptions (H)

Hourly | aily | warthiy |

Device Interface FH Customer Speed # - Threshold - Descri
Exceptions %
15.140.11.216 =l H HF 0.0 Mbiz =l 1 =l A
15.27.0.180 me H Customer Unazzigned 0.0 b=z a5 1 me
15.144.185.0 1 H Customer Unazzigned 0.0 bz a5 1 lan
1547 191,42 AGTTT221 H Customer Unazzigned 0.0 bz a5 2 mecpd
15.7.208.117 1 H Customer Unazzigned 0.0 bz a5 1 lan
15.62.32.255 1 H Customer Unazzigned 0.0 bz a5 1 =]
15.3.208.119 =l H Customer Unazzigned 0.0 bz S5 1 =l
152322275 24 H Customer Unazzigned 0.0 bz a2 1 24
15.12.151.182 1 H Customer Unazzigned 0.0 bz 47 1 =] i
;I e
Details Protocol Group Location Country
me1 ethermetcsmacd Unknown Group Location Unassigned Unknown Country

% Digcard Rate for 15.27.0.190: me1
% of Actual Traffic Discarded

n =l
o =
=

o,
(o8]

!

% of Traffic Discarded

-
I

0
fon 12:00 AWM Tue 1200 AM  Wed 12:00 AW
Time
T Max Discard % (H)
Aorg Discard % (H)
— DiscardThreshold

Recent Daily Max Discard Rates and Times

The maximum discard rates, as measured ower the polling interval, and the hoor during «which they occurred.

Maximum Discard Rate and Time
28 Discards persecond on Jul 22 2003 9:00F -
53 Discards persecond on Jul 21 20032 1:004M
36 Discards persecond on Jul 20 20032 9:00F b
8 Discards persecond on Jul 19 2003 3:0024M
66 Discards persecond on Jul 18 2003 S:004M
G§9 Discards persecond on Jul 17 2003 9:00F
8 Discards persecond on Jul 16 2003 9:00F W
F2 Discards persecond on Jul 15 20032 4004
34 Discards persecond an Jul 14 2003 11:00F M
58 Discards persecond on Jul 82003 Z2:004M
54 Discards persecond on Jul 7 2002 5004 LI
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Exceptions by Type

Interface Reporting

Error Exceptions

[

invent

This report has one entry for each monitored intedface that experienced eror exceptions vesterday. An exception occurs when

inbound or outbound error traffic (uith respect to total traffic) exceeds the threshold set for that individual inteface. F/H indicates full

[T T

Interfaces with Error Exceptions Yesterday
Sorted by Exception Count

Hourly | Daity | Morthiy |

Exceptions for 15.23.224.223: Ethernetd

# Exceptions

]
Mon 00:00 Mon 15:00 Tue 06:00 Tue 21:00
Tirme
W Total Exceptions (H)

Haurly | Daity | Morthiy |

% Error Rate for 15.23.224.223: Ethernetd
% of Actual Traffic with Errors

% of Traffic with Errors

Mon12:00 AWM Tue 12:00AM  WWed 12:00 Ak

Time
" hdax Errar % (H)
— Auorg Errar % (H)
— ErrerThreshald

I

=i~
4

Device Interface FH Speed Customer # . Thresho
Exceptions %
1512922187 41 H 0.0 Mbdfz Customer Unazzigned 11 1
1523224223  Ethemetd H 100 Mbdz  Customer Unazzigned T 1
15252240 z F In: 11.0 hdbdz Out: 11.0 Mbis Customer Unassigned In:10 Cut:d z
15.128.164.162  Ethemetd H 0.0 Mbdfz Customer Unazzigned 2 1
zemrar] z H 0.0 Mbdfz Customer Unazzigned 2 1
158.728 cir) H 0.0 Mbdfz Customer Unazzigned 2 1
15.16.122.32 FazstEthermetdM7 H 0.0 Mbdfz Customer Unazzigned 1 1
15232275 25 H 0.0 Mbdfz Customer Unazzigned 1 1
15.140.11.216 141 F In: 100.0 hbds Qut: 100.0 hibis HF In:1 Qutd
Kl |
Details Protocol Group Location Country
Ethernetd ethernet-cemacd Unknawn Group Location Unassigned Unknan Country

Recent Daily Max Error Packet Rates and Times

The maximum error packet rate, in packets per second, for each of the 1ast 31 days

Maximum Error Rate and Time
1 Errors persecond on Jul 22 2003 2:004M
0 Errars persecond on Jul 21 2003 9:00F
1 Errors persecond on Jul 20 2003 9:00F W
1 Errors persecond on Jul 19 2003 9:0024M
1 Errors persecond on Jul 18 2003 4:00F W
1 Errors persecond on Jul 17 2003 1:00F W
1 Erors persecond on Jul 16 2003 120024
2 Ermars persecond on Jul 15 2003 14:00F W
1 Errors persecond on Jul 14 2003 9:0024M
1 Errors persecond an Jul 8 2003 7:004M
0 Errars persecond on Jul 7 2003 9:00F M
1 Errars persecond on Jul & 2003 9:0040
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Interface Reporting (ﬁﬁ]

Utilization Exceptions invent

Thiz report has one entry far each monitored inteface on the nebwodowhich experienced utilization exceptions vesterday. An
excention oceurswhen inbound or outbound utilization exceads the threshold zet for the protocol orthe threshold forthe individual

Interfaces with Utilization Exceptions Yesterday

Sorted by Exception Count
Device Interface Full:Half Speed Customer #_ Threshold De
Exceptions %
151401163  Seriald F In: 1.5 Mbis Out: 1.5 Mbis  Customer Unassigned In:8d Out:g4 Fil S
151401163 Seriald.q F In: 1.5 Mbis Out: 1.5 Mbis  Customer Unassigned In:84 Out:g4 Fil Se
15264021 28 H 10.0 Mbss Customer Unassigned 10 30 1C
sener] 2 H 10.0 Mbss Customer Unassigned 2 30 hr
158728 a1 H 10.0 Mbss Customer Unassigned 3 30 1C
158728 aMe H 10.0 Mbss Customer Unassigned 2 30 1C
15264018 2034 H 10.0 Mbss Customer Unassigned 2 30 1C
15232276 1 H 10.0 Mbss Customer Unassigned 1 30 1
152322785 10 H 10.0 Mbss Customer Unassigned 1 30 ‘1Ev
£ 00T R 44 [N ] AN O kAR A~ Codeamoar e amsianad 4 an 4
4 | ;
Details Protocol Group Location Country
Seriald.q frameRelay Unknawn Group Loczation Unazzigned Unknan Country
Hourly | Dty | northiy | Hourly | Daity | marthiy |
Exceptions for 15.140.11.63: Serial0.1 LWilization for 15.140.11.63: Serial0.1
90
e
; AR
£72
&
]
B 2 a4
s (L
"gm G a6
=
i o
£ =18
[ |
2 0 .
Mon 12:00 AWM Tue 1200 AM  Wed 12:00 A
Time
Mon 00-00 Tue 0300 Tue 18:00 Wed 09:00 _ Maxn Utiizatien 1F)
X Ao In Utilization (F)
Time  Max Qut Wilization (F)
W Total in Exzeptions (F) FAorg Out Utilizatian (F)
O Total out Exzeptions (F) — WMilThreshald
Recent Daily Max Liilization and Times
The maxi mum percentage dtilization, 25 measured ower the polling intereal, and the hour during which it occorred.
Maximum Wilization and Time
84.92% Input Uil on Jul 22 2003 5:004M 84.93% Output Uil on Jul 22 2003 5:004AM -
84.13% Input Uil on Jul 21 2003 S:004M 24.14% Output Uil on Jul 21 2003 5:004AM
0.00% Input Wil on Jul 20 20032 F:00F M 0.00% Ouotput Util an Jul 20 2003 G004
0.00% Input Ll on Jul 19 20032 1:00F M 0.00% Ouotput Util an Jul 19 2003 30040
0.00% Input Wil on Jul 18 20032 S:00F M 0.01% Output Util an Jul 18 2003 50040
0.00% Input Wil on Jul 17 2003 11:00F M 0.00% Output Util on Jul 17 2003 2:004M
0.00% Input Ll on Jul 16 20032 90080 0.00% Ouotput Util an Jul 16 2003 Z:004M
0.00% Input Wil on Jul 15 20032 2:00F M 0.00% Ouotput Util an Jul 15 2003 Z:004M
0.00% Input Ll on Jul 14 2003 S:008M 0.00% Ouotput Util an Jul 14 2003 9:004M
0.00% Input Uil on Jul 8 2003 30020 0.00% Ouotput Util an Jul 8 2003 9:004M
0.00% Input Uil on Jul 7 2003 1:00F M 0.00% Ootput Util an Jul 7 2003 2:004M
0.00% Input Uil on Jul & 2003 G:00FM 0.00% Ouotput Util an Jul & 2003 1:004M j
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10 Locations and Protocols

Interface Reporting includes two summary reports. One offers a location perspective on
performance, rolling up performance data by location, and the other offers a protocol
perspective on performance, rolling up performance data by protocol. The key metrics in both
reports are volume, exceptions, and utilization.

Summary reports provide aggregated data across multiple systems. The location summary
report provides the following information:

e Number of active, monitored interfaces by location

¢ Volume for one customer by location

e Volume for all customers by location

e  Hourly, daily, and monthly analysis of exception counts by location
e  Hourly, daily, and monthly utilization by location

The protocol summary report provides the following information:

e Number of active, monitored interfaces by protocol

¢ Volume for one customer by protocol

e Volume for all customers by protocol

e  Hourly, daily, and monthly analysis of exception counts by protocol
e  Hourly, daily, and monthly utilization by protocol

You may investigate a location customer-by-customer, or you may investigate a location by
looking at performance data for every customer at that location simultaneously. Similarly, you
may look at the performance of a protocol for one customer, or for all customers.

Use summary reports to find out how the number of actively monitored interfaces compares
location to location, or protocol to protocol, and to compare exception counts location to
location or protocol to protocol. If a customer needs an upgrade, or if a location needs an
upgrade, the summary reports should make that clear. In addition, if a recent upgrade at one
location was expected to lower the exception count for that location, the location summary
report should provide the evidence you need to verify that the situation has improved.

Both summary reports are reproduced below.
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Interface Reporting

Location Executive Summary

[

invent

This report has one entry for each Customer and Location combination on the nebmode. This report onky contains metrics for ports that are

administratively up.

Locations with Traffic Yesterday

Location Customer # Int
Location Unassigned All Customers
iazhington HF
Washington Cust
razhington Cust1
Washington Cust2
iazhington Cust3
Washington All Customers
M ok HF
Mew ok Cust
Mew ok Custi
Mewn ok Cust2
Mew ok Custa
Mew ok All Customers
Chicagno HF
Chicago Cust
Chicagno Cust1
Chicago Cust2
Chicagno Cust3
Chicago All Customers
Marwar He

Hourly | Daiy | Morthiy |

Exception Counts
26.00
20.80
15.60

10.40

Total Exceptions

5.20

o
Sun 12:00 AM Mon 12:00 Ak

Sun 12:00 P

Time

Wl utilization Exzeptions
D Discard Exceptions
MErer Exeptions

368
116

0

21

18

15
240

6

az
115

a7

43
394

23

a7

29

33

36

228
L) ;I

Hourly | Daily | Morthy |

Total Yolume

23.40
19.50
1560

11.70

Total Volure [(Gh)

T.an

.00

a
Sun 12:00 Ak

Sun 12:00 PM fon 12:00 Abkd
Timne
Hoirly | Daily | Morthiy |
Liilization
0.z20
c
=
i
= 0.10
=1
ES
a
Sun 12:00 A Sun 12:00 PM fon 12:00 Abkd
Tirne
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Interface Reporting

Protocol Executive Summary

[

invent

Thiz report has one entry for each Customer and Protocol combination on the netoof. WMilization acrosz a protocal iz calculated using
the total traffic generated by administratively up intefaces @ Int) of that protocol type, divided by the total available speed from those

interfaces.

Customers with Traffic Yesterday

Customer Protocol #Int
All Customers  ifType=0 7 1
HF ifType=0 7 il
All Customears other 25
HF other T
Cust other =}
Cust other T
Cust2 other T
Custz other ]
Cust gigabitEthernet 2
All Customers  gigabitEthernet 3
Cust1 d=1 2
Al Customers dst 2
HF propPointTaPointSerial 19
Cust propPointToPointSerial 18
Cust1 propPointTaPointSerial 24
Custz propPointToPointSerial 19
Cust3 propPointTaPointSerial 19
All Customers propPointToPointSerial a9
HF sofhwareloopback
Cust sofhmareloopbads 3
Cust1 sofhmareloopback 2
Hourly ] Daily | Morthiy |
Exception Counts
o0.01
T
&
i
m
=
)
Sun 12:00 A ton 12:00 Abkd Tue 12:00 AM

Tirne

M Utilization E:xceptions

Yolume
HiA &
MHid

2.1 Gh
1.6 b
16 b
1.6 b
16 b
1.6 Gb 1
0 bytes
0 brytes
Mk
MHiA
3.3 Mb
3.3 Mb
2.3 Mb
3.3 Mb
3.3 Mb
21.6 Mb
0 ytes
0 brytes

0 bytes .:J

Houry | Daity | Marthy |

%a Litilization

Hourly | aity | marthy |

Total wWolume [GE)

100.10

2580

71.50

57.20

4230

28 B0

14.20

Traffic Yolume

a
Mon 12:29 P ton 12:20 P

Tirne

10010

24680

T1.50

57.20

4230

22E0

14.30

a
bdon 12:29 P

Lilization

bdor 12:20 P
Tirne

Locations and Profocols
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11 Capacity Planning

In addition to monitoring the exceptions created by occasional spikes in traffic, Interface
Reporting is concerned with gradual increases in utilization and the resulting capacity
problems that may arise a few months from now. Interface Reporting includes the following
capacity planning reports:

e (Capacity Planning by Interface (Busy Hour)
e (Capacity Planning by Device

e Capacity Planning by Location

e Capacity Planning by Protocol

The interface version of the report focuses on the baseline busy hour average (a rolling
average of 42 busy hours) and projected increases or decreases in the baseline busy hour
average. The selection table sorts interfaces by the F30 forecast for the baseline busy hour
and allows you to compare the following statistics for each interface:

e Baseline busy hour
e F30 forecast for baseline busy hour
e Utilization threshold

The baseline busy hour will change slightly every day, since, each day, the oldest busy hour
value will be dropped from the average, while a new busy hour (for yesterday) will be added to
the average. Note that the value for each busy hour is itself an average (based on four
samples) and should not be confused with peak usage. For a portion of that busy hour, actual
usage may have been much higher (or much lower) than the average.

The other three capacity planning reports are customer-oriented, so your first step is to select
a customer. The selection table will then rank the elements (devices, locations, or protocols)
belonging to that customer. The ranking is done according to rate of growth and the rate of
growth is calculated by dividing the F30 forecast by the baseline busy hour. In all four
capacity planning reports, the graphs beneath the selection table provide additional forecast
data (baseline details, the F60 value, the F90 value, and day-of-week values) and a Grade of
Service score that assesses the impact of discard, error, and utilization exceptions.

Samples of two capacity planning reports follow; the first report is from the Interface folder,
the second report is from the Device folder .
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Interface Reporting

Busy Hour Capacity Planning

[

invent

Thiz report provides detailz about the interfaces whose 20 day forecasted busy hour utilization is greater than their utilization threshold.
The busy hour (BH) utilization iz the maximum avarage utilization acrosz a complete hour during the day. FfH = Full or Half Duplex.

Device

zenverd
System
15.140.11.63
15.140.11.63
15.68.184.2

Interfaces Where Forecasted Utilization Exceeads Threshold

Sorted by Forecasted Wilization

Interface FH Customer BH Avg. LHil.
z H Customer Unazzigned 57
2 H Acme 21
Seriald.q F Customer Unazzigned In:14 Qut:14
Seriald F Customer Unazzigned In:14 Qut:14
Seriald F Customer Unazzigned In:220 Qut:136

Standard | Histu:ur\,n'l Day of Weekl

200

160

120

Utilization %

20

40

Busy Hour {EH) WHilization Forecast for Systemd: hmel

Wed 00:00

F30 BH Liil.

187

207

In:21 Qa2
In:21 Qa2
In:40 DutA732

LHil.
Threshold

a0

a0

o

o

=lu]

Opazeline BH Awerage (H)
O+ 20 pay= 8H M
O+ &0 pays 8HH
[+ 20 pay= 8H M

Descr.

hmel
hmel
Seriald. 1
Seriald
Seriald

Hourly  Daily | porthiy |

(LYY

Critical

Bad

Grade of Service for Systen1: hmel

For Interval: Wed Jun 11 2003 - Wed Jul 23 2003 [Arericaiblesw Y ork]

| == e 1= o | — S

Thu 00:00  Sun 00:00 Wed 00000 Sat00:00 Tue 00:00  Fri00:00  Mon00:00

Date

M Utilization Exceptions
Ooiscard Exzeptions
M Error Exceptions
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Capacity Planning

Interface Reporting (bﬁ]
Device Capacity Planning invent
Thiz report provides utilization forecasts and related information aggregated by dewice and customer groupings. All metrics are for
administratively up intefaces unless othenvize stated. % Growth reprezents the expected 20 day busy hour utilization growth. Select
a grouping from the list on the left.
:n TI?:':‘T;L . Device A:ﬂif " F30 vt U;:?;'le F30 Volume % Growth
Acme 15.24.176.154 0.0 oo G1.7 hb 0 bytes 1,161 &
Customer Unassigned tzshpi18.cnd.hp.com 0.4 27 1.3 Ghb 2.8 Gh [=c]u]
HF 15.140.11.63 0.0 uln] 21 Gh 14.3 Gb 5589
Systams 0.z 1.2 1.4 Gh 1.6 Gb 373
zenrer] 16.8 G8.1 48 Gb 19.0 Gb 304
Swstem 12 0.3 1.2 23 Gh 3.2 Gh 303
15.12.151.159 0.z ul=] 43.6 hib 159.8 hb 227
gold.raze.hp.com 1.4 4.5 5.2 Gh 12.4 Gb 215
15.12.151.160 0.z ul=] 429 hib 166.5 hib 213
15.252.8.45 0.1 03 526.7 b G659.1 Mb z09
hpatG17.atl.hp.com 0.1 0z 25 Gh 3.0 Gh 136
bictite.cnd.hp.com 0.1 0z 739.1 b 1.1 Gb 173
15.10.47 253 0.4 1.0 450.9 hib G665.9 Mb 164
tzhp19.cnd.hp.com 0.0 uln] G81.5 b 365.8 Mb 163
ROS5042MOR2 0.3 o4 Ga7.7 b 1.1 Gb 151
15.95.132.169 0.3 ul=] G5.0 hib 119.2 hb 136 LI
System Contact System Hame System Location

Standard I Historyl Dary of VWeek

Lilization Forecast for 15.24.176.154

Oeaseline BH Aorerage
O+ 30 pays
O+ 80 Days
H+ 20 pays

% Utilization

Wed 00:00

Hourly | Daily  Manthly

Exception Counts for 15.24.176.154

M utilization Exceptions
Opiscard Exceptions
W Emar Exceptions

Total Exceptions

Sun 00:00
mMaonth
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12 Service Level Management

Service level agreements between service providers and customers commonly stipulate a
minimum response time and minimum availability. The purpose of the Service Level
Management (SLM) reports is to improve service level monitoring for both parties, enhancing
precision and making violations easier to spot.

SLM reports focus on SNMP response time and availability. Response time measures delay
within the management infrastructure, that is, delay between the datapipe and the device
being polled, not delay between clients and servers. While you would not want to infer from a
high SNMP response time that users are seeing the same delay, the response time that users
are seeing could be similar if the device is the source of the delay.

Availability measures the percentage of time a device has been operational. This metric
provides insight into device outages as reported through the SNMP sysUpTime attribute. To
calculate the availability of individual interfaces, PI combines the sysUpTime value for the
device with two interface attributes, ifOperStatus and ifLastChange.

Use the SLM reports to identify specific interfaces, devices, protocols, and locations that are
experiencing availability or response time problems. The report in the Interface folder is
interface-oriented, beginning with a list of device/interface combinations; the other SLM
reports are customer-oriented, allowing you to select a customer/element combination.

The initial selection table looks at yesterday’s availability, and ranks items by availability,
lowest to highest. Use the graph to the right to view availability on an hour by hour basis,
then compare the hourly graph to the daily graph to find out whether yesterday’s activity was
an isolated incident, not likely to occur again, or part of an ongoing trend. The second table,
response time, looks at yesterday’s response time and ranks items by response time, highest
to lowest.

Interface Reporting includes four Service Level Management reports. Two samples follow, one
from the Interface folder and one from the Device folder.
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Interface Reporting

Service Level Management

[

invent

The Senvice Leval Management report indicates whether interfaces are meeting contracted service levels for availability and response
time. Select an inteface from the table to zee pedformance overtime. Only interfaces with less than 100% availability will be listed. Usze

the AwvailabilityP ot parameter to constrain which intefaces are displayed.

Interfaces with Lovwest Availability for Yesterday

Device
15.43 23520
15.43.235.20

15241152
15241152
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60
15.24.117 .60

Availahility

Tue Jul 22 2003

Interface
A3
A
Seriald
Seriald.1
Seriald.1
Seriald2
Serialdz
Seriald.qg
Serialda
Seriald G
Serialdy
Serialds
Serialdg
Seriald 10
Serialt.1
Serial1.2

Max Response Time

Availability Dest

u}

R e e e e [ e e e e e e Y e Y s R s e

Highest SMMP Response Time by Interface

Device

1514011 216
1514011 216
1514011 216
1514011 216
1514011 216
1514011 216
15.140.11 216
1514011 216
1514011 216
1514011 216
1514011 216
1516122 32
1514011 216
1514011 216

Tue Jul 22 2003

Interface

204
12
28
202
2M
211
215
205
27
20
24

e

Seri:
Seri:
Seri:
Seri:
Seri:
Seri:
Seri:
Seri:
Seri:
Seri:
Seri:
Seri:

Seri:

Seric v
»

FastEthermetlME

210

21z -
L3

Hourly I Draily I

Availability
For: 15.43.235.20: A4
harn Jul 21 12:00 Ak - \Wed Jul 23 10:00 A0
100
an
<11]

40

Areailability %

20

I
Mon 12:00 AWM Tue 12:00 AM  WWed 12:00 AW
Time

Hourly I Ciaily I

Response Times
For: 1514011 216: 10/ 00 utp ethernet (cat 345)
Mar Jul 21 12:00 AM - Yyed Jul 23 10:00 LM

20,000

—-
(=2}
=
=
=

12,000

8,000

4,000

Response Time (ms}

0
hlon 12:00 At Tue 12:00 P
Time
— bz Response Time
— FAurg Response Time
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Interface Reporting m
Device Service Level Management invent
The Senice Level Management report shows whether groups of interfaces are meeting contracted senice lewels for awailability and

response time based on Customers and Device. The number of interfaces (# Int) includes only those interfaces which are
administratively up. Select a dewice fram the tables on the left to see pedformance over time.
Availability % Daily | Haurly |
Ordered by Lowest Availability for the Day
Tue Jul 22 2003 Availability % {from sysUpTime)
" Sun Jun 22 2003 - Tue Jul 22 2003

Device Customer Int. Availability 100
15.24.117 .60 Customer Unassigned 41 z =]

Testl Customer Unazsigned 52 4
15402443 Customer Unassigned 27 7
15.43.235.20 Customer Unassigned 34 3 a0

15.8.72.10 Customer Unassigned a2 11

15.162.112.2682 Customer Unazsigned 4 15

15.25.40.27 Customer Unassigned a2 18 =2 &0

15.27.0.95 Customer Unaszsigned 4 20 =

Test? Customer Unazsigned 11 27 o %
15.1.83.129 Customer Unassigned 11 27 ?—U
15.24115.2 Customer Unaszsigned 11 27 E 40
Test3 Costomer Unassigned 7 =}
15.27.0.190 Customer Unassigned 47 az
15.25.40.25 Customer Unassigned a2 az

15.0.72.28 Customer Unassigned 5 35 20

15.8.72.11 Customer Unassigned a2 a6
15.17.187 .59 Customer Unassigned 16 ar

15.25.40.5 Customer Unassigned a2 ar o
15.140.11.216 HP 16 7 Wied 12:00 AW Wed 12:00 AM
15.25.40.19 Customer Unaszsigned 28 38 Diate
15.16.122.32 Customer Unassigned 28 jinl j

Response Times Greater than 200 (ms) Daily I Hourly I
COrdered by Highest SMNMP Responsze Time
Tue Jul 22 2003 Response Times
" Thu Jul 17 2003 - Tue Jul 22 2003
Device Customer Max Avg
int. 20,000
15.140.11.216 HF 16 12812 15258 =
15.2.144.2 Customer Unazzigned 45 2672 =]
15232275 Customer Unazzigned 28 TA59 jein ]
157,182 16 Customer Unazzigned 2 T.7a0 516 16,000
15.70.186.75 Customer Unazzigned 2 GAa3z 1,208 o
151258120 Customer Unazzigned 1 6462 1019 E
Test1 Custemer Unassigned 52 Baz0 361 EWﬂDU
151289128 Customer Unazzigned 2 5.7a0 aza =
151047 253 Customer Unazzigned 2 5887 1,057 3
Test? Customer Unazzigned 4 5,350 227 — E_ 2,000
Test3 Customer Unazsigned 11 5206 2049 ]
15.162.112.282 Customer Unazzigned 4 5182 a35 x
1512891258 Customer Unazzigned 2 4781 Fjci] 4,000
15.2.208.1159 Customer Unazzigned 59 4766 G652

1508726 Customer Unazzigned 88 3531 365 -

1587248 Customer Unazzigned a2 3290 Jeinic]

150728 Customer Unazzigned a2 33228 jein Thu 1DQZU|:| A Sun 1 2:00 A
15.25.40.27 Customer Unazzigned a2 3266 ars Date
15.25.40.25 Customer Unazzigned a2 3110 a7
15.25.40.21 Customer Unassigned 88 3084 374 ~ hax Response Time
15.9.72.10 Customer Unassigned 88 3082 374 — Awg Response Time
1587223 Customer Unazzianed 22 Zod 320 j
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13 Administration Reports

The following table outlines the scope of each admin report.

Admin Report Information Provided

Configuration and Logging e Configuration settings for:
— Logging level
— Data filtering
— Provisioning.
e List of recent log entries
e Entries are listed by component
e Each entry is time-stamped
e Each entry indicates duration in seconds
e JR_map_p is the most common component

e The number of entries per poll (two entries per poll in
the sample report) is related to number of index types

Inventory ¢ List of customers
e List of devices for each customer
e [P address, make, model, description
e List of interfaces on each device
e Attributes for each interface:

— AdminStatus

— Protocol

— Full/Half

— Speed

— Threshold

— Description

Top Level Inventory e Total number of devices for each customer
e Total number of interfaces for each customer

e List of devices by make and model
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Admin Report

Information Provided

System Performance

Processes that took place during the last 2 hours:

Name

Start time

Duration

Rating

Bar chart showing duration of each process in seconds

Processes that took place since yesterday:

Name

Start time

Duration

Rating

Bar chart showing duration of each process in seconds

See below for samples of these reports:

Configuration and Logging
Inventory

System Performance
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Administration Reports

Report Pack Administration
Configuration and Logging

[

invent

This report displays configuration information relating to Interface Reporting collections, and lists the most recent log table entries for
report rack internal procedures. Logging to this report is open to all installed report packs. Use the 'Component' parameter to filter the

displayed data.

Configuration Paramet:
Logging Lewel T%

[rata Filtering

Frowvisianing

Time
Mrad Jul 23 1109 Ak
Mrad Jul 23 1108 At
Mrad Jul 23 10:52 A
Mrad Jul 23 10:52 A
Mrad Jul 23 10:237 A
Mrad Jul 23 10:237 A
Mred Jul 23 10:22 A
Mred Jul 23 10:22 A
Mrad Jul 23 10:09 Ak
Mred Jul 23 10:08 Ak
Mred Jul 23 09:52 At
Mrad Jul 23 09:51 Ak
Mred Jul 23 09:237 A
Mred Jul 23 09:237 A
Mred Jul 23 09:22 A
Mred Jul 23 09:22 A
Mrad Jul 23 0909 Ak

Component

IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p
IR_map_p

IR Mapping Procedure Configuration

Current Value Meaning
1 High Lewvel and Errars Only
u} Report on all interfaces
u} Use provisioned data anly

ReportPack Log Entries

Info:
Info:
Info:
Info
Info:
Info:
Info
Info:
Info:
Info
Info:
Info:
Info
Info:
Info:
Info
Info:

Message
411 palled rows were mapped to SRIRDewPaorts in 2 seconds.
1725 polled rovs were mapped to SRIRDevPorts in S seconds.
411 palled rows were mapped to SRIRDewPorts in 0 seconds.

$ 1734 polled rove ware mapped to SRIRDevPorts in 5 seconds.

411 palled rows were mapped to SRIRDewPorts in 0 seconds.
1734 polled rovs were mapped to SRIRDevPorts in 4 seconds.

411 polled rovs were mapped to SRIRDevPorts in O zeconds.

1734 polled rovs were mapped to SRIRDevPorts in 4 seconds.
411 palled rows were mapped to SRIRDewPorts in 0 seconds.

AT2T polled roves weare mapped to SRIRDewPorts in 10 seconds.

411 palled rows were mapped to SRIRDewPorts in 0 seconds.
1734 polled rovs were mapped to SRIRDevParts in 11 seconds.

411 polled rovs were mapped to SRIRDevPorts in O zeconds.

1735 polled rovs were mapped to SRIRDevPorts in § seconds.
411 palled rows were mapped to SRIRDewPaorts in 1 seconds.

21733 polled o weare mapped to SRIRDevPorts in S seconds.

411 palled rows were mapped to SRIRDewPaorts in 2 seconds.
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Interface Reporting (ﬂ/n

Inventory Report invent

This report has one entry for each costomer and provides inventony information for the devices assigned to that customer and the
interfaces on those devices. Modify the report constraints to limit the number of intedfaces displayed. Only intedfaces that were polled

westerday mill be displayed.

Devices Associated with the Chosen Customer

Customer Id
Acme 1 Device Make Model Des=cription
Customer Unassigned 2 15.6.96.4 Cisco 2522 15.6.96.4
HF 2
Interfaces on 15.6.96.4
Change Constraints to Modify the List
Interface AdminStatus Protocol Full/Half Speed Threshold %  Description
Ethernetd Up ethernetcsmacd H 10.0 Mbss U:E0 0o B Ethernetd
Seriald Up frameRelay F In: 1.5 Mbis Out: 1.5 Mbis U570 D1 B Seriald
Seriall Up frameRelay F In: 1.5 Mbis Out: 1.5 Mbis U570 D1 B Seriall
Serial2 Up frameRelay F In: 115.0 Kbis Out: 115.0 Kbis U770 D1 B Serial2
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Interface Reporting

Reporting System Performance

[

invent

This report prowides total duration details in seconds for groups of related tasks in the report pack. The information can be used to

assess if the system is approaching its processing limits.

Hourly Process Durations

Process Hame

For the Last 2 Hours

StartTime

DevPaort_Summans  led Jul 23 11:20 Ahkd
DevPaort_Summans  Wied Jul 23 10:20 Ak
DevPaort_Summans  Wied Jul 23 09:20 Ak

Process Hame

DevPort DMF_Summary
DevPort DMF_Summary
Device_DMF_Summary
Device_DMF_Summary
Froperty_Ilmport
Froperty_Ilmport

Daily Process Durations

Since Yesterday

StartTime

ied Jul 23 0400 Ahd
Tue Jul 22 04:00 Ahd
red Jul 23 0405 AR
Tue Jul 22 0405 Akl
red Jul 23 0400 Ahd
Tue Jul 22 04:00 Ahd

Du::t}mn Rating
24 Excellent
40 Excellent
Duration Rating
(s}
a245 Food
a10 Food
o4 Excellent
a7 Excellent
18 Excellent
17 Excellent

Duration (s}

200

160

-
[l
o

==
=

Hourly Durations

]
Mon 00:00 Mon 21:00 Tue 17:00

g00

430

3

R

Duration

120

0
Mon 00:00 Sun 00:00 Fri00:00

Time

Daily Durations

Date

Administration Reports
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A Pl Report Packs

Business Technology

Reporting Solution

Application Application Report Pack:

e WebLogic SPI

e WebSphere SPI
Database Database SPI Report Pack

HP Business Process Insight

BPI Report Pack

HP Internet Services

Internet Services Report Pack

HP Network Node Manager

NNM Event & Availability Report Pack

HP Operations OVO Report Pack
HP Service Desk Help Desk Report Pack
Change Management Report Pack
SLM Integration Report Pack
IP Telephony e C(Cisco IP Telephony Call Detail
e C(Cisco IP Telephony Gateway Statistics
MPLS VPN MPLS VPN Report Pack
Networking Infrastructure Usage

e Interface Reporting

e Device Resource Report Pack

LAN/WAN Edge

¢ Frame Relay (SNMP only)
e ATM (SNMP only)

WAN Core

e Frame Relay (multiple switch vendors)
e ATM (multiple switch vendors)
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Business Technology

Reporting Solution

Networking (continued)

Traffic Profiling

RMON II

NetFlow Interface
NetFlow Global View
IP QoS Report Pack
Class-Based QoS

Quality Assurance

Cisco Ping Report Pack
Service Assurance
IP Access Rate

System Resources

System Resource Report Pack

Appendix A



B Options for Customizing Reports

Group

These are some of the way you can customize reports:

e Import properties (customers and locations)

e Apply group filters

e Apply constraints

e Modify the time period (so that you can view archive data in archive reports)
e Add details about interface attributes

e Change the default view of tables and graphs

Although creating group filters is a task for an administrator, any user looking at a report can
apply constraints, change view options, or switch to archive reports. For details about view
options for tables and graphs, see Appendix C, Editing Tables and Graphs.

Filters

If you want to share reports with customers, you must produce customer-specific reports. To
produce customer-specific, perform these tasks:

e Use Common Property Tables to import properties (customer names and device locations)
e Create a group account for all of the users affiliated with each customer
e Create a group filter for the group account

For more information group filters, refer to the PI Administration Guide.
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Applying Constraints

Editing a parameter applies a constraint. The constraint eliminates the data you are not
interested in seeing. If you edit the Customer Name parameter, data for every customer
except the customer you typed in the Customer Name field drops from the report. You can
apply multiple constraints at the same time. Interface Reporting supports the following
parameters:

e Customer Name
e Customer ID

¢ Location Name
¢ Location ID

¢ Device Name

e Make

e  Model

If you are using the Web Access Server to view reports, edit parameters by clicking the Edit
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters
window opens, enter the constraint in the field and click Submit.

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the
Modify Parameter Values window opens, click the Current Value field. Type a new value and
click OK.

Viewing Archive Reports

If you are using the Web Access Server to view reports, switch to archive data by following
these steps:

1 Click Preferences.

2 Expand the Deployed Items folder.

3 Click View. The View Settings panel opens.
4 Click the box next to Allow Element Editing.

Appendix B
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invent

A . A —
a Preferences View Settings
] User Profile
"['_‘j Site Appearance
Ea Deployed Items
e istn Allow Add to Favorites within Report
i M
# (7 Scheduler

Attribute

[ Allow Downloads

[] Allow Parameter Editing
[ Allow Element Query Info
[ Open in New Browser
Allow Element Editing

[] Allow Viewing Element in New Frame

5 Click Apply. The system displays the following message:

You have successfully updated your report view settings.
Click Catalog.

6
7 Expand the System folder.

8 Expand the Interface Reporting folder.
9 Expand the Archive folder.

10 Expand the Interface folder.
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=l System
"ﬁ 0 Launch Point

() Cisco_IPT_Admin
) Cisco_IPT_CallDetails
E‘H Interface Reporting
] Admin
E'a Archive
) Admin
E‘a Interface
[+ Exceptions =
] Interface Reporting Interface Availability Detail
*[u] Interface Reporting Interface Busy Hour Capacity Planning
E] Interface Reporting Interface Grade of Senice
Interface Reporting Interface Near Real Time
] Interface Reporting Interface Near Real Time - Simple

s S Ak S AR B R S P PSR TR o e o e PO,

o

11 Double-click any report.

12 When the report opens, click the paint icon in the upper right. The Table Edit window
opens.

13 Click Absolute and enter a start time and an end time.

14 Click Submit.
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3 Table Edit - Microsoft Internet Explorer provided by Hewlett-Pa... |;||E|E|

Table Edit

Max Rows: |5_EIEEI

AND
Constraints: full_half = [Full_Half]
ifAdminStatus = [AdminStatus]

Time Range: (® Relative

OThis hour v
®Last 6 | hour(s) | [ until now
() Absolute

Start Time: !Dn:t A7 04:00 AN 2007 |

End Time: | Oct 17 10:33 AM 2007 |

I@ Dane \Q Local intranet
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Importing Properties

You have the option of populating reports with node-level properties and interface-level
properties. Node-level properties are sourced from Common Property Tables. Interface-level
properties can be sourced from the network, or read from a property import file that you
create yourself from scratch. If you prefer, you can also export existing property data from PI,
modify what you get from PI, and then re-import this file with your changes. The following
forms are available for updating properties:

e Change Protocol Defaults

¢ Change Interface Properties

e Change Interface Customer

¢ Change Interface Location

¢ Change Interface Description
¢ Administer Interface Poll Flag

The Administer Interface Reporting form does not pertain to object properties. Use it to
modify the behavior of the package itself.

102 Appendix B



C Editing Tables and Graphs

Any table or graph can be viewed in several ways. Although the default view is usually
adequate, you can easily change to a different view. If you are using Report Viewer, right-click
the object to open a list of view options. If you are using the Web Access Server, follow these
steps to change the default view of a table or graph:

1 Click Preferences on the links bar.
Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

o O AN

Click the Edit icon next to the table or graph.

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options

Sek Time Period, .,
Change Constraink Yalues. .
Select Modes|Interfaces. ..

Change Max Rows. ..
Wiew in new Frame

Frint Table. ..

Expart Element as CSY. ..
Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

ged Table Yiewer

Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

IpPrecedence
o]

B B e R s T = o B v o e e | i o = o B o R e T = v N e

Polled IP @05 Statistics Data - Input

Over Previous 6 Hours

Switched Bytes
105,688

o o o o o

00

08,234

o QO e [ o A o A o

o7 539

102,775

[ e o [ [ o e |

o o oo o o o

Switched Plis

G745

o o o o o o

[aic}

o

G

DADDDDD£DDDDDDD

S5

o T e [ o o )

Gal

o

[ e o [ [ o e |

54,

]

o o oo o o o

Time Period
Tue Oct 29 0700 Ak
Tue Oct29 07:00 Al
Tue Oct 20 07:00 AM
Tue Oct 29 07:00 Ak
Tue Oct20 07:00 AM
Tue Oct 29 0700 Ak
Tue Oct29 07:00 Al
Tue Oct 20 07:00 AM
Tue Dot 29 06:45 Ahd
Tue Oct 29 05:45 AM
Tue Oct 29 05:495 Ahd
Tue Oct 20 0645 A
Tue Oct 29 0545 AWM
Tue Dot 29 06:45 Ahd
Tue Oct 29 05:45 AM
Tue Oct 29 05:495 Ahd
Tue Oct 29 06:30 A
Tue Oct 20 05:20 AM
Tue Oct 29 06:30 Al
Tue Oct 20 05:30 AM
Tue Oct 29 0G:30 Ak
Tue Oct 29 06:30 A
Tue Oct 20 05:20 AM
Tue Oct 29 06:30 Al
Tue Oct20 0515 AM
Tue Oct 29 0G:15 Al
Tue Oct29 06:15 AM
Tue Oct 20 0515 AM
Tue Oct 29 06:15 Al
Tue Oct20 0515 AM
Tue Oct 29 0G:15 Al
Tue Oct29 06:15 AM
Tue Oct 20 05:00 AM
Tue Oct 29 06:00 Ak
Tue Oct 20 05:00 AM
Tue Oct 29 0G:00 Ak
Tue Oct29 06:00 Al
Tue Oct 20 05:00 AM
Tue Oct 29 06:00 Ak
Tue Oct 20 05:00 AM
Tue Oct 29 05:495 Ahd
Tue Oct20 05:45 Al
Tue Oct 29 05:45 AM
Tue Dot 29 05:45 Ahd
Tue Oct 29 05:45 AM
Tue Oct 29 05:495 Ahd
Tue Oct20 05:45 Al
Tue Oct 29 05:45 AWM

=0l ]
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View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

Add | Sverla. .

Remove Overlay

Set Time Period...
40000 1 Zhange Constraint Yalues. ..

Seleck Modes/Interfaces. ..

32T 20 1 Displayed Data

| arid
Legend
Skyle

294540 1

- v v

163.60 T “hange Max Rows. .

Display Dakta Table
21.80 1 [
Export Element as C5Y, ..

Display: Cerlay Mata Table

. Sep: 17 Sep: 24 Sep: o5 Sep: =0 Export Graph Swerlay Data as T,

View in new Frame
Print Graph. ..
[elete Graph

The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.

Grid Add these to the graph:

X axis grid lines
Y axis grid lines

X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
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Option

Function

Export Element as CSV...

Same as the table option shown above.

View in New Frame

Opens graph in a Graph Viewer window.

Print Graph

Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

add Cwverlay .,

Remove Cwerlay

Phd

Set Time Period. .,
Change Constraint Yalues, ..
Select Modes)Interfaces. ..

Displayed Data [ % !

Grid b

Legend b /\

Shyle Area

i“hange Max Rows... Stacking Area

Display Data Table Bar

Export Element as C3Y... Stacking Bar

Display Owetlay Daka Table Pie

Export GraphOwerlay Data as ©5y)., # Flot

Wigw in mew Frame Scatter Plot

Prink Graph. .. Hi-La | =

Delete Graph Hi-Lo-Open-Close —
—roa  andle

| Aaa
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

Disconnect Cause Hourly Totals for Yesterday
For Selected Gateway Group

14340 ¢

119.50 +

9560

olurne

7170 1

Sat Feb 24 06:00 &AM EST
Mormal Disconnect (107 js 74.00

s

0400  0E00  OS00

2390 ¢

000 1z:00 1400 1600 400 0 2000 2200

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

11,524.00 1
9,529.20 4
7,454.40 1

4 7E3.60 ¢

Forecast Minutes

238480 4
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Day= Of The Week

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows

in units of ten.
200.00
160,00
120000
0000

40.00

b 01 Tue 02 ied 03

M :org Utilization ¢H)
I 1 a3 Utilization tH)
B Uil Threshald

Appendix C



Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.
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31.40 1
15.70 1
u] 1 +
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

M Under 1 minute

[ Between 1 and § mingtes

O Betmeen & and 20 minutes

O Between 30 mintes and 2 hours
M Between 2 hours and 12 hours
M Ovver 12 hours

If you are looking at data for more than one day, you will see multiple pie graphs, one for each
day.
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Display Data Table

This option changes a graph into a spreadsheet.

T pata table for 8.1

A Bxis I Average I
Tue Feb 19 .., 0.209
Tue Feb 19 .., 0.621
Tue Feb 19 .., 1.026
Tue Feb 19 .., 0.3e2
Tue Feb 19 .., 1.171
Tue Feb 19 .., 1.051
Tue Feb 19 .., 0.284
Tue Feb 19 .., 0.826
Tue Feb 19 .., 1.483 %
Tue Feb 19 .., 0.9e7
Tue Feb 19 .., 1.471
Tue Feb 19 .., 1.208
Tue Feb 19 .., 1.123
Tue Feb 19 ... 0.93
Tue Feb 19 .., 1.497
Tue Feb 19 .., 0,806
Tue Feb 19 .., 0.725
Tue Feb 19 .., 0.875
Tue Feb 19 ... 1.06
Tue Feb 19 .., 1.254
Tue Feb 19 .., 0.518
Tue Feb 19 .., 0.822
Tue Feb 19 .., 0.971
Tue Feb 19 ... 0.77

=0l xi

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

i Graph Yiewer I w4
Hetwork Response Time
Cisco_04

Tue Feb 19 12:00 Ahd - Tue Feb 19 11:00 Fhd

Seconds

Tue 05:00 AM Tue 11:00 PM
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Glossary

availability

The percentage of time a device has been operational. Identifies device outages as reported
through the sysUpTime variable. Calculated by combining device sysUpTime with interface
ifOperStatus and interface ifLastChange.

avg volume

This metric is found in capacity planning reports. It refers to average daily volume during the
baseline period.

baseline busy-hour

This value is the average of 42 busy-hour values recorded during the rolling baseline period.
This value is static for one day only. It will be different tomorrow, when yesterday’s busy hour
is factored into the calculation that determines average Busy Hour. Baseline busy hour and
forecasts for future baseline busy hour values appear in capacity planning reports.

busy-hour

This value reflects a relatively persistent phenomenon and, when combined with multiple
busy-hour values over the baseline, is used to predict future performance. The busy hour
value is an average of multiple samples taken during the hour. Do not confuse busy-hour with
peak. During the busy hour, actual utilization can be significantly higher than the busy-hour
average.

country

This value is imported by the provisioning interface. If not provisioned, the field reads
unknown.

daily

A view showing daily performance for the previous 31 days. The most recent day in this view
is yesterday.

day of week

A forecast, derived from baseline data, that assigns a growth rate to each day of the week.

discard rate

The percentage of packets discarded by the interface. Data about discards is sampled during
each poll cycle (by default this is four times an hour); based on those samples, PI calculates an
average and a maximum discard rate.
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discard threshold

The point at which an acceptable percentage of discarded traffic becomes an abnormal
percentage and possibly impacts response time. If the interface is full duplex, the same
threshold value is applied to both in and out packets separately.

error rate

The percentage of packets with errors as reported by the interface. Data about errors is
sampled during each poll cycle (by default this is four times an hour); based on those samples,
PI calculates an average and a maximum error rate.

error threshold

The point at which an acceptable percentage of errored traffic becomes an abnormal
percentage and possibly impacts response time. If the interface is full duplex, the same
threshold value is applied to both in and out packets separately.

F30/F60/F90

The level where utilization (or volume) is expected to be 30, 60, and 90 days from now.
Calculated by applying linear regression to busy-hour levels over the baseline period.

group
This value is imported by the provisioning interface. If not provisioned, the field displays
unknown.

growth rate
F30 utilization divided by average busy-hour.

hourly

A view showing performance for the last two days and whatever portion of today has elapsed.
The minimum time range is 48 hours; the maximum is 72 hours.

interface

An entry in the SNMP ifTable for the device, representing a physical or a logical interface.

location

This value imported by the provisioning interface. If not provisioned, the field reads unknown.

monthly

A view showing performance for each month over the last two years. Blank until data
collection has been functioning for at least one month.

protocol

The textual name associated with the enumerated ifType of the interface.

response time

Delay within the network management structure, specifically, delay between the datapipe and
the device. If the device is causing the delay, this value may point to device resource issues.



threshold

The line between normal and abnormal performance. When this line is crossed, an exception
is recorded. Thresholds are set to default values that are easily changed to reflect individual
needs.

utilization

The total number of octets traversing the interface as a percentage of the total possible
number of octets, using the ifSpeed property. If an interface is full duplex, the table displays
utilization in each direction. Groups of interfaces have their utilization calculated by taking
the total traffic on all administratively up interfaces in the group and dividing that by the
total possible bandwidth. Utilization for a group of interfaces is more reliable when all the
interfaces in the group use the same protocol.

utilization threshold

The point at which the number of octets traversing the interface is considered detrimental to
the service level required by network users. In the case of full duplex interfaces, the same
threshold value is applied to in and out packets separately.
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adding details about vendors and models, 52
Administer Interface Reporting (form), 33, 67
Allow Element Editing (archive reports), 98
archive reports, 98

average volume, 111

B
baseline busy hour, 111
busy hour, 81, 111

C

Capacity Planning, 81

Capacity Planning by Device, 81
Capacity Planning by Interface, 81
Capacity Planning by Location, 81
Capacity Planning by Protocol, 81
Change Interface Customer (form), 63
Change Interface Location (form), 63
Change Interface Properties (form), 61
change max rows option, 105

Change Protocol Defaults (form), 59
Change Protocol Defaults form, 33
child pollers, 28

collection_manager (command), 22
Configuration and Logging Admin Report, 89
country, 111

customer-specific reports, 97

custom views of data or property tables, 22

D

daily, 111

data filtering mode, 66
Datapipe Manager, 22
day of week, 111

demo package, 19, 31

Device Exception Hots Spots, 69
directed-instance polling, 32, 65
discard exceptions, 73

discard rate, 111

discard threshold, 112

Display Data Table, 105
displayed data option, 105

distributed systems, 29
Add Database Wizard, 22
switching off aggregations, 22
trendcopy pull commands, 22

E

editing parameters, 98

error exceptions, 73

error rate, 112

error threshold, 112

EtherChannel Exception Hot Spots, 69
Exception Hot Spots, 69

Executive Summary, 77

extracting packages from the report pack CD, 23, 30

F

F30, 112
F60, 112
F90, 112

G

grid options, 105

group, 112

group_manager (command), 22
group filters, 97

growth rate, 112

H
hourly, 112

115



|

ifAdminStatus, 49
ifAlias_Collection, 32

ifDescr, 46

ifDescr_Collection, 32
ifIndex_Collection, 32
ifLastChange, 85
ifName_Collection, 32
ifOperStatus, 85

ifSpeed, 46

ifType, 46

importing properties, 102
Install, 31

Interface, 12, 31

interface, 112

interface-level properties, 46
Interface Reporting Device, 32
Interface Reporting Location, 32
Interface Reporting Protocol, 32
Interface Reporting Thresholds, 32
Interface Reporting Vlan, 32
Inventory Admin Report, 89
IR_Config.pl utility, 30, 32

L

legend options, 105
location, 112
Location Summary Report, 77

logging level, 66

M
model properties, 53
monthly, 112

N

node-level properties, 46

nterface, 12

o)

object categories in the object model, 34
OIDs per PDU, 28

OPNET, 31
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P

Package, 35

polling policies, 21

Polling Policy Management, 32
PropertyData directory, 48
property export command, 48
property import command, 48
protocol, 112

Protocol Summary Report, 77

provisioning mode, 33, 66

R
report types, 15

response time, 112
RIRRouterSystem table, 43

S

service level management, 16, 85
setting the interface poll flag, 65
SHIRDevPorts table, 42

SNMP Edit Profile window, 27
SNMP retry default, 28

SNMP timeout default, 28
SNMPv2 GETBULK retrieval, 28
SourceDirectory path, 52

style options for graphs, 105
System Performance Admin Report, 90
sysUpTime, 85

T

Table Manager, 42

TEEL files, 51

threshold, 113
trendtimer.sched, 28

Trunk Exception Hot Spots, 69

V)

unassigned interfaces, 46

unreachable report, 16

UPGRADE, 24

upgrading Common Property Tables, 31
Use Absolute Time, 103



using the batch-mode property import, 48
utilization, 113

utilization exceptions, 73

utilization threshold, 113

\'}

vendor properties, 52
view in new frame, 104
VLAN Exception Hots Spots, 69
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